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CAUTION!

Impulse is a sophisticated waterhammer and surge transient modeling program
designed for qualified engineers with experience in waterhammer analysis and
should not be used by untrained individuals. Impulse is intended solely as an aid
for pipe flow analysis engineers and not as a replacement for other design and
analysis methods, including hand calculations and sound engineering judgment.
All data generated by Impulse should be independently verified with other
engineering methods.

Impulse is designed to be used only by persons who possess a level of
knowledge consistent with that obtained in an undergraduate engineering course
in the analysis of pipe system fluid mechanics and is familiar with standard
industry practice in waterhammer analysis.

Impulse is intended to be used only within the boundaries of its engineering
assumptions. The user should consult the Impulse Help System for a discussion
of all engineering assumptions made by Impulse.

Information in this document is subject to change without notice. No part of this Quick Start
Guide may be reproduced or transmitted in any form or by any means, electronic or mechanical,
for any purpose, without the express written permission of Applied Flow Technology.

© 2025 Applied Flow Technology LLC. All rights reserved.
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C H A P T E R 1

Introducing Impulse

Welcome to Impulse, Datacor’s powerful waterhammer modeling tool. With
Impulse you can model transients caused by a wide range of pipe system
behavior. This will allow you to understand transient pressure extremes, and
when necessary, size and locate surge suppression equipment.

Impulse includes a steady-state solution engine which solves for the system’s
initial conditions. These results are used to automatically initialize the transient
model.

Impulse has two available Add-on Modules for purchase which extend the
modeling capabilities into new areas.
� The Settling Slurry (SSL) module allows the engineer to perform the

complex property and system interaction calculations associated with
settling slurry flows.

� The Pulsation Frequency Analysis (PFA) module allows the engineer to
determine resonant frequencies that can result in excessive vibration and
damage to systems.

Designing for waterhammer

Waterhammer can cause catastrophic failure of pipe systems and damage
expensive equipment. Properly addressing such issues at the design stage is
essential. An Impulse model allows the engineer to better understand and predict
the dynamic behavior of the pipe system. When undesirable waterhammer
transients are identified at the design stage, different strategies to reduce surge
pressures can be evaluated. These may include using surge suppression
equipment, modifying the design, or modifying the system operation.

Sometimes the undesirable transients are not discovered until after the system is
built. In such cases, Impulse can provide critical insight into the cause of the
problem and allow the engineer to assess design and/or operational
modifications to resolve the issue.
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Modeling capabilities

Standard version capabilities
� Transients in open and closed (recirculating) systems

� Network systems that branch or loop

� Systems with valve transients

� Systems with pump transients

� Systems with turbine transients

� Systems with pressure or flow control valve transients

� Systems with limited transient cavitation and liquid column separation

� Systems with surge suppression devices such as accumulators, surge tanks,
and vacuum breaker valves

� Systems with variable density and viscosity

� Multiple design cases in a single model file

� Non-Newtonian fluid behavior

Add-on module capabilities (optional)
� System performance calculations for settling slurries (SSL)

� Identification of natural acoustic frequencies (PFA)

� Positive displacement pump speeds which excite resonant frequencies (PFA)

Impulse provides hundreds of standard loss values from handbook sources for
pipe system components, and also allows the engineer to enter their own loss
data. Variable loss models that depend on flow are supported.

Engineering assumptions in Impulse

Impulse is based on the following fundamental fluid mechanics assumptions:
� Liquid flow (system is fluid-full and single phase)

� One-dimensional flow

� No chemical reactions

� Wavespeed remains constant during transients

� Non-condensable gas release is negligible

� Fluid density is not affected by pressure waves in the system

� Bubbles that form during transient cavitation do not move
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The Steady-State Solver

Before a waterhammer model can be run, the initial steady-state conditions are
required. Impulse obtains the steady-state solution using a Newton-Raphson
matrix solution algorithm to obtain a mass and momentum balance. The
algorithm is similar to that used in the acclaimed Fathom.

If desired, Impulse can be run in “Steady Only” mode where only the steady
flow pipe hydraulics are modeled. When run in “Transient” mode, the steady
flow solution is used to automatically initialize the transient solution. This
convenience helps the user avoid the often
error-prone process of manually setting up the initial conditions, and it allows
the user to quickly and safely modify and rerun the model.

The Transient Solver

Impulse employs the traditional Method of Characteristics (MOC) to solve the
transient equations of pipe flow. A mass and momentum balance is performed at
all computing stations in each pipe, accurately representing the propagation of
transient pressure waves throughout the system.

The MOC is an explicit solution technique, where the Transient Solver marches
in time for a duration specified by the user.

Thermophysical property data

Impulse offers several sources from which thermophysical properties can be
derived:
� ASME Steam/Water - Properties are calculated with the equations of state

from the IAPWS Industrial Formulation (1997), also used to generate the
ASME steam/water tables.

� Chempak™ - Optional add-on for purchase which contains data for
approximately 700 fluids and supports user-specified fluid mixtures.
Chempak is licensed from Madison Technical Software.

� NIST REFPROP - The Reference Fluid Thermodynamic and Transport
Properties Database is licensed from the National Institute of Standards and
Technology (NIST) where properties for approximately 150 fluids are
calculated via equations of state. REFPROP supports user-specified fluid
mixtures.

� Impulse Standard - Common fluids from various industry standard sources
have been curve fit to optimize calculation speed.

� User Specified Fluid - Custom fluid properties can be entered if the desired
working fluid is not available via the other sources. Impulse requires
density, viscosity, and bulk modulus at a minimum. Vapor pressure can be
optionally entered to check for cavitation.

� User Library Fluid - A custom fluid can be saved to the User Library for
repeated use in the future.
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Impulse Primary Windows

Impulse has several Primary Windows that work in an integrated fashion. Each
is located on a separate, moveable tab. You work exclusively from one of these
windows at all times. For this reason, they are referred to as Primary Windows.

Workspace
The Workspace Primary Window is where the user creates the graphical
representation of the system. Engineering data is input on pipe and junction
property windows which are opened by double-clicking the objects.

The Workspace Layers are also located on this Primary Window and allow the
user to display both input and output data superimposed on the pipe system
schematic.

Model Data
The Model Data Primary Window summarizes the engineering input data from
the Workspace into categorized tables. This allows for easy review of the system
inputs, and double clicking cells will open the pipe or junction properties for
quick editing.

Output
The Output Primary Window offers a powerful and diverse range of features for
reviewing analysis results which are organized into categorized tables and lists.
The Output allows the user to easily compare multiple design scenarios with
color coded rows, details errors or design requirement violations, and prepare
the results for documentation.

Graph Results
The Graph Results Primary Window allows the user to create a wide array of
graphs with various parameters which are integral to gaining a deeper
understanding of the pipe system’s behavior. The user can adjust various
formatting settings such as axis ranges, labels, colors, and create dual y-axis or
stacked graphs. The settings can be saved into templates called Graph List Items
so that the graphs can be easily reproduced.

Input vs. Output
Table 1.1 summarizes how each Primary Window relates to input and output
data. The Workspace can display output data by using Workspace Layers after
the simulation has been run.
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Table 1.1 Primary Window Input vs. Output Data

Primary Window Can Display Input Can Display Output

Workspace ✓ ✓

Model Data ✓

Output ✓

Graph Results ✓

Note: Impulse supports multiple monitors. You can click and drag any of the
Primary Window tabs off of the main Impulse window, where it can then be
moved anywhere on the screen, including onto a second monitor. To add the
Primary Window back to the main Impulse program window bar, simply close
the Primary Window.

Note: To ensure that your results are the same as those presented in this
documentation, these examples should be run using default settings, unless you
are specifically instructed to do otherwise.
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C H A P T E R 2

Valve Closure Example

This chapter is designed to give you the big picture of Impulse's layout and
structure. Some of the more basic concepts will be used to build a four-pipe,
five-junction model which shows the waterhammer transients that result when a
valve is closed.

Topics covered
� Model building basics

� Entering Pipe and Junction data

� Defining Analysis Setup

� Entering transient data

� Sectioning pipes

� Graphing output results

� Using Workspace Layers

Required knowledge

No prior knowledge is required for this example.

Model file

This example is intended to be built from scratch to help familiarize yourself
with the steps to define a complete model in Impulse. For reference purposes
only, the completed example model file can be found in the Examples folder as
part of the Impulse installation:

C:\Users\[username]\Documents\Datacor\Impulse 11\Examples
� Metric - Beginner - Valve Closure.imp
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Problem statement

For this problem, water flows from two separate supply tanks and combines into
a single 12 inch line before flowing to a downstream reservoir. The flow is
controlled by opening and closing a valve in the 12 inch line.

This model will simulate the closure of the valve over a period of one second.
The valve will stay closed for the remaining simulation duration.

Graph the pressure at the inlet of the valve over the entire simulation duration to
determine the maximum pressure that occurs at the valve during the transient.

Step 1. Start Impulse
► To start Impulse, open the all applications list in the Windows Start Menu,

expand the Impulse 11 folder, and choose Impulse 11 to launch the application.
This refers to the standard menu items created by a standard installation.

A. The Startup window
As Impulse is started, the Impulse Startup Window appears, as shown in Figure
2.1. This window provides you with several options you can choose before you
start building a model.

Figure 2.1 Startup Window with Modeling Preferences collapsed

Some of the available actions from the Startup window are:
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� Open a recent model, browse to a model, or browse to an example

� Activate an Add-on Module

� Select ASME Water or a recently used fluid

� Review or modify Modeling Preferences: select a Unit System, filter units,
choose a Grid Style, select a Default Pipe Material, and more

� Access other Resources such as Help Files and Video Tutorials

If this is the first time that you have started Impulse, Modeling Preferences will
be expanded in the middle section of the Startup Window, as shown in Figure
2.2. If this is not the first time that you have started Impulse, the Startup
Window will appear with Modeling Preferences collapsed, as shown in Figure
2.1.

When collapsed, you can view your current Modeling Preferences at the bottom
of the Start a New Model section. To further review or adjust your preferences,
click the Modify button (see Figure 2.1).

Figure 2.2 Startup Window with Modeling Preferences expanded

► With Modeling Preferences expanded, as in Figure 2.2, select Both with
Metric Defaults under Unit System. The Filter section can be used to limit the
number of units that are shown in the interface.

The Common Plus Selected Industries option adds units from the industries you
select. You can use the Show Sample Units option to see the model units based
on your selections. After modifying your Modeling Preferences, click
Remember My Preferences and Hide.
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► Click Start Building Model.

The Workspace window is shown initially, as seen in Figure 2.3. The tabs in the
Impulse window represent the Primary Windows. Each Primary Window
contains its own toolbar that is displayed directly beneath the Primary Window
tabs.

Figure 2.3 The Workspace Primary Window

B. The Workspace window
The Workspace window is the Primary Window for building your model. This
window has three main areas: the Toolbox, the Quick Access Panel, and the
Workspace itself. The Toolbox consists of the object icons on the far left. The
Quick Access Panel is on the far right and gives easy access to the Scenario
Manager, object Properties, and Workspace Layers.

You will build your model on the Workspace using the Toolbox. The Pipe
Drawing tool on the upper-left is used to draw new pipes on the Workspace. The
Annotation tool beside it allows you to create annotations and auxiliary graphics.

Below the two drawing tools are the different types of junctions available in
Impulse. Junctions connect pipes and also influence the pressure or flow
behavior of the pipe system. Drag and drop any of the junction icons from the
Toolbox to add them to the Workspace.

Holding your mouse pointer over a Toolbox icon identifies the tool’s function.

C. Hiding the Quick Access Panel
By default, the Quick Access Panel is pinned to the Workspace window so that
it is always displayed. The Quick Access Panel can be unpinned so it is only
displayed when the mouse is moved over a tab displayed on the right edge of the
Workspace window. You can unpin the Quick Access Panel by clicking on the
pin icon displayed in the top-right corner of the Quick Access Panel (Figure
2.3). The Quick Access Panel will be pinned for the remainder of the examples
in this guide.
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Step 2. Build the model

To lay out this example model, you will place several junctions on the
Workspace. Then, you will connect the junctions with pipes.

A. Place a reservoir
► To start, drag a Reservoir junction from the Toolbox and drop it on the

Workspace. Figure 2.4 shows the Workspace with one reservoir.

Objects and ID numbers
Items placed on the Workspace are called objects. Impulse uses three types of
objects: pipes, junctions, and annotations.

All pipe and junction objects on the Workspace have an associated ID number.
Junctions are prefixed with the letter J, and pipes are prefixed with the letter P.
You can assign a name in the object’s Properties window, and the visibility of
both the name and ID number can be controlled through the use of Workspace
Layers. You can also drag the ID number/name text to a different location to
improve visibility.

The reservoir you have created on the Workspace will take on the default ID
number of 1. You can change this to any desired integer between 1 and 99,999
that is not already assigned.

Figure 2.4 Valve closure model with the first junction placed

Editing on the Workspace
You can move junctions on the Workspace to new locations. You can also cut,
copy, paste, and duplicate junctions from the Edit menu or using keyboard
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shortcuts. Undo is available for most arrangement actions on the Workspace.

B. Place the other junctions
If a new junction type you want to add is already on the Workspace, you have
the option of duplicating that junction. You do this by choosing Duplicate from
the Edit menu. Either duplicate the first Reservoir or drag a new Reservoir
junction onto the Workspace. Place the new Reservoir somewhere below the
first Reservoir junction (Figure 2.5).

Drag a Branch, Valve, and third Reservoir junction and drop them on the
Workspace so that your model appears similar to Figure 2.5.

Note: The relative location of objects is not important. Pipe lengths and junction
elevations are defined through property windows. The relative object locations
on the Workspace establish the connectivity of the objects but have no bearing
on the actual length or elevation relationships. The Isometric grid (see Chapter
5) can be used to visually represent the three-dimensional nature of a system.

Figure 2.5 Valve closure model with all junctions placed

The calculations will not be affected if the icons do not line up exactly.
However, your model may have a nicer appearance if they do. You can align the
icons by using the Align features from the Arrange menu.

► Before continuing, save your work. Press CTRL+S, use the Save button on the
Common Toolbar, or go to the File menu and select Save. Impulse models use
the *.imp file extension.
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C. Draw a pipe between J1 and J3
Now that you have all of the junctions placed, you need to connect them with
pipes.

► To create a pipe, click the Pipe Drawing Tool icon on the Toolbox. The pointer
will change to a crosshair when you move it over the Workspace. Left-click and
drag to draw a pipe near the junctions, similar to that shown in Figure 2.6.

Figure 2.6 Valve closure model with the first pipe drawn

The pipe object on the Workspace has an ID number (P1) that is shown near the
center of the pipe.

► To place the pipe between J1 and J3, click and drag the pipe so that the left
endpoint falls within the J1 Reservoir junction (see Figure 2.7). Next, grab the
right endpoint of the pipe and drag it until the endpoint falls within the J3
Branch icon (see Figure 2.8).
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Figure 2.7 Valve closure model with the first pipe partially connected

Figure 2.8 Valve closure model with the first pipe fully connected

D. Add the remaining pipes
A faster way to add a pipe is to draw it directly between the desired junctions.

► Activate the Pipe Drawing Tool again, position the mouse pointer on the J2
Reservoir, then press and hold the left mouse button. Stretch the pipe across to
the J3 Branch, and then release the mouse button. Continue drawing Pipes P3
and P4 as indicated in Figure 2.9. After all the pipes are drawn, all the objects in
the model are graphically connected. Save the model again.
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Figure 2.9 Valve closure model with all pipes and junctions placed

Reference positive flow direction
The arrow on each pipe indicates the reference positive flow direction for the
pipe. The direction does not influence the direction that the flow may go, it
influences sign convention only. If the direction of flow calculated by the Solver
is the opposite of this reference flow direction, then the output will show the
flow rate as a negative number.

You can reverse the reference positive flow direction by choosing Reverse
Direction from the Arrange menu, selecting the Reverse Pipe Direction button
on the Toolbar, or pressing F3.

Although the reference positive flow direction does not need to point in the
direction of the actual flow, when used with pumps, the reference direction
determines the suction side and discharge side of the pump.

Note: Examples of other junctions that depend on pipe directions include
Control Valves, Check Valves, and Area Changes.

Note: Some users find it desirable to lock objects to the Workspace once placed.
This prevents accidental movement and disruption of the connections. You can
lock all the objects by first selecting all objects by using CTRL+A or the Edit
menu by clicking Select All. Then use CTRL+L or go to the Arrange menu and
selecting Lock Object. The lock button on the Workspace Toolbar will appear
depressed, indicating it is in an enabled state. Alternatively, you can use the grid
feature and snap to grid. The grid options can be modified through the Arrange
menu or User Options window.
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Step 3. Specify Analysis Setup

The Analysis Setup window allows the user to define fluid properties, view
undefined pipe/junction properties, section pipes, adjust simulation duration,
enable Add-on Modules if purchased and available on the current license, and
specify other simulation settings from a single central location.

► Click Analysis Setup on the Common Toolbar. This opens the Analysis Setup
window (Figure 2.10). The Analysis Setup window contains various groups
depending on which Add-on Modules you may be using. Each group has one or
more items. A fully defined group has every item within it defined with all
required inputs. Complete every group to run the Solver. A group or item that
needs more information will have a red exclamation point to the left of the
group or item name. After completing a group, the group icon shows a green
circle with a checkmark. After defining all groups, thus completing the Analysis
Setup, the Model Status light in the lower-right corner turns from red to green.

Note: If you are running your model in steady-state mode only, the Pipe
Sectioning and Output group and the Transient Control group will appear to be
fully defined because they pertain to the transient analysis only. To change back
and forth between the steady-state and transient analysis, choose either “Steady
Only” or “Transient” from the Simulation Mode/Duration panel in Analysis
Setup or from the Analysis menu.

A. Modules
Under the Modules group, click on the Modules item to open the Modules panel,
shown in Figure 2.10. Here, you can enable and disable Add-on Modules if they
are available on the license. These Add-on Modules include Pulsation Frequency
Analysis (PFA) and Settling Slurry (SSL). By default, the model will have all
modules disabled. Make no changes to this panel for this example.

Figure 2.10 On the Modules panel, you can enable or disable any module

15 Impulse 11 Quick Start Guide



B. Fluid Properties
The Fluid Properties group consists of several items: Fluid, Viscosity Model,
Variable Fluids, and Laminar and Non-Newtonian Corrections. On the Fluid
panel, you specify the fluid used in the model.On the Viscosity Model panel,
you select which viscosity model to use - Newtonian is used by default. On the
Variable Fluids panel, you can specify constant fluids properties, the default
selection, or variable fluid properties. Finally, on the Laminar and Non-
Newtonian Corrections panel, you can specify the type of corrections to apply
with laminar flow or Non-Newtonian fluids.

By default, only the Fluid panel requires input. Click on the Fluid item to open
the Fluid panel. You can directly enter density and viscosity data (using User
Specified Fluid), select a fluid from the Impulse Standard fluid library, or select
Water Data from ASME Steam/Water Tables. Additionally, you can select from
fluids and/or create mixtures using the NIST REFPROP library (included in
Impulse) or the Chempak library (an optional add-on to Impulse). You can also
add your own custom fluids to the User Library.

► Select the Impulse Standard library and select Water (liquid) in the Fluids
Available in Library list, then click the “Add to Model” button. Enter a
temperature of 21 deg. C. This satisfies the required inputs for the Fluid panel
and Fluid Properties group. This Fluid panel should appear as shown in Figure
2.11.

Figure 2.11 The Fluid panel is where you specify the fluid

C. Pipes and Junctions
The third group in Analysis Setup, Pipes and Junctions, is not as straightforward
to satisfy as the first two. This item encompasses the proper input data and
connectivity for all pipes and junctions.
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Object status
Each pipe and junction have an object status. The object status tells you whether
the object is defined according to Impulse’s requirements. To see the status of
the objects in your model, click the light bulb icon on the Workspace Toolbar
(alternatively, you could choose “Show Object Status” from the View menu).
Each time you click the light bulb, “Show Object Status” is toggled on or off.

When “Show Object Status” is on, the ID numbers for all undefined pipes and
junctions are displayed in red on the Workspace. Objects that are completely
defined have their ID numbers displayed in black. These colors are configurable
through User Options from the Tools menu.

Because you have not yet defined the pipes and junctions in this example
problem, all the object ID numbers will change to red when you turn on “Show
Object Status”.

Showing undefined objects
Another useful feature is the List Undefined Objects window (Figure 2.12). This
can be opened from the View menu by clicking on “List Undefined Objects”, or
from the Workspace toolbar. Here all objects with incomplete information are
listed. Clicking on an undefined pipe or junction will display the property data
that is missing. Click the close button (black X icon) in the bottom-right to stop
showing this window.

Figure 2.12 The List Undefined Objects window lets you see the
undefined properties for each undefined object

Enter data for the reservoirs
► To define the first reservoir, open the J1 Reservoir Properties window (Figure

2.13) by double-clicking on the J1 icon.

Note: You can also open an object’s Properties window by selecting the object
(clicking on it) and then either pressing the Enter key or clicking the Open
Pipe/Junction Window icon on the Workspace Toolbar.
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► Enter the following properties into the J1 Reservoir Properties window:

1. Make sure the Tank Model is set to “Infinite Reservoir”

2. Enter 15 meters for the Liquid Surface Elevation. You can assign any unit
found in the adjacent drop-down menu of units.

3. Enter 0 barG for the Liquid Surface Pressure.

4. Enter 3 meters for the Pipe Depth (ensure that the radio button next to Pipe
Depth is selected).

Note: Change default units for many parameters (such as meters for length) in
User Options, found in the Tools menu, under Preferred Units.

You can give the junction a name, if desired, by entering it in the Name field at
the top of the window. By default, the junction's name is not specified. If a
junction name is entered, it will be displayed in the Model Data, Output, and in
Workspace Layers. In Figure 2.13, the name of this Reservoir has been changed
to Supply Tank A.

Most junction types can be entered into a custom library, allowing the junction
to be used multiple times or shared between users. To select a junction from the
custom library, choose the desired junction from the Library Jct list in the
junction’s properties window. The junction will get the properties from the
library.

Figure 2.13 Properties window for the J1 Reservoir

The “Copy Data From Jct” list will show all the junctions of the same type in
the model. This will copy the user selected parameters from an existing junction
in the model to the current junction.
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Using the tabs in the properties windows
The information in the Properties windows is grouped into categories and placed
on separate tabs. Click the tab to bring its information forward. Figure 2.13 is an
example of a Reservoir Properties window.

If there is only one pipe connected to the reservoir, the depth can be entered
directly on the diagram on the Reservoir Model tab for convenience.
Alternatively, enter the depth, regardless of the number of pipes, on the Pipe
Depth & Loss Coefficients tab (also called the pipe table). The pipe table allows
you to specify entrance and exit loss factors for each pipe connected to the
reservoir (in this case there is only one). The default selection is for the loss
factors to be specified as zero. You can change the loss factors by clicking
within the pipe table and entering the loss.

The Optional tab allows you to enter different types of optional data. Depending
on the junction type, you can enter initial guesses for the Solver, specify Design
Factors, set Special Conditions (such as closing a valve or turning off a pump),
and change the junction icon.

Each junction has a tab for notes, allowing you to enter text describing the
junction or documenting any assumptions.

The highlight feature (on by default) displays all the required information in the
Properties window in light blue. You can toggle the highlight on and off by
pressing F2 with the properties window open or by double-clicking an empty
area above the tabs of the properties window. The highlight feature can also be
turned on or off by selecting “Highlight in Pipe and Jct Windows” from the
View menu.

► Click OK and click Yes to display the Reservoir name if prompted. With
“Show Object Status” turned on, you should see the J1 ID number and name
turn black again, informing you that the junction is fully defined.

► Next, repeat this process for junctions J2 (Supply Tank B) and J5
(Discharge Tank) with the following data:
� For J2, use a Liquid Surface Elevation of 14 meters, a Pipe Depth of 3

meters, and a Liquid Surface Pressure of 0 barG.
� For J5, use a Liquid Surface Elevation of 1.5 meters, a Pipe Depth of 1.5

meters, and a Liquid Surface Pressure of 0 barG.

The Inspection feature
You can check the input parameters for J1 quickly, in read-only fashion, by
using the Inspection feature. Position the mouse pointer on the J1 Reservoir icon
and hold down the right mouse button. An inspection window appears, as shown
in Figure 2.14.

Inspecting is a faster way of examining the input (and output if results are
available) than opening the Properties window.
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Figure 2.14 Inspect junction properties from the Workspace by clicking
and holding the right mouse button

Enter data for the branch
► Open the J3 Branch Properties window and enter an elevation of 0 meters.

Enter data for the valve
The J4 Valve junction will be the initiator of the transient.

► Open the J4 Valve Properties window and enter the following data (Figure
2.15):
1. Enter an Inlet Elevation of 0 meters.

2. Choose the User Specified Loss Source, Cv as the Loss Model, and enter a
value of 1000 (this is the steady-state Cv).
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Figure 2.15 Input data for the J4 Valve junction

3. Click the Transient tab and select Time under “Initiation of Transient” to
indicate that the valve closure will be initiated at the time you specify, then
enter the following Cv vs. Time data for the valve’s Cv at various times
during the simulation (Figure 2.16).

Time (seconds) Cv

0 1000

0.4 400

0.8 100

1 0

2 0

Note that the first data point (Cv = 1000 at time zero) must match the steady-
state value (entered on the Loss Model tab) and will be automatically populated.
The transient data represents the valve as initially open. The valve then closes
over a period of one second (a Cv of zero means the valve is closed). The valve
then stays closed for the rest of the simulation.
4. Click OK. There should now be a “T” symbol next to the Valve junction on

the Workspace, indicating that transient data is entered for the junction.
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Figure 2.16 Transient input data for the J4 Valve junction

Enter data for Pipe P1
Data for pipes and junctions can be entered in any order. In this example, the
junctions were done first. The next step is to define all the pipes. To open the
Pipe Properties window, double-click the pipe object on the Workspace.

► First, open the Pipe Properties window for Pipe P1. The Pipe Model tab
opens by default (Figure 2.17).
1. In the Pipe Material dropdown, select Steel - ANSI.

2. In the Size dropdown, select 10 inch.

3. In the Type dropdown, select STD (schedule 40).

4. Specify the Length as 60 meters.

5. Verify the Friction Model is set to Standard.

6. Verify the Pipe Support is set to Thick-Walled Anchored Upstream.
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Figure 2.17 Pipe Properties window for Pipe P1

The Pipe Properties window
The Pipe Properties window offers control over all important hydraulic
parameters that are related to pipes.

The Inspect feature can be accessed not only from pipes and junctions located
on the Workspace, but also from within the Properties window of each pipe (and
certain junctions). This is helpful when you want to quickly check the properties
of objects that connect to a pipe or junction whose Properties window you
already have open.

To Inspect a junction connected to a given pipe, position the mouse pointer on
the connected junction’s ID number in that pipe’s Properties window (located at
the top right of the Pipe Properties window) and hold down the right mouse
button. This process can be repeated for any junction that states the upstream
and downstream pipe in the junction’s Properties window. You can jump to that
junction’s Properties window by double-clicking the connected junction’s ID
number, or use the Jump button to jump to any other part of the model.

Wavespeed
The wavespeed is a very important parameter in waterhammer analysis. The
wavespeed can be calculated with reasonable accuracy from fluid and pipe data,
or it may be available from test data or industry publications. If the wavespeed is
not known (which is typical), then the Calculated Wavespeed option is the
preferred option. In this case, data is required for pipe wall thickness, modulus
of elasticity, Poisson Ratio, and pipe support details. Data for pipe wall
thickness, modulus of elasticity, and Poisson Ratio are built into the pipe
material libraries supplied with Impulse, and was automatically obtained when
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the Steel - ANSI, 10 inch, STD (schedule 40) option was chosen. The calculated
wavespeed is 1319 meters/sec (see Figure 2.17). Click OK.

Enter data for the other pipes
Similar to Pipe P1, enter the following data for the other pipes. Note that all
pipes will use the Thick-Walled Anchored Upstream Pipe Support and the
Standard Friction Model.

Pipe Size (inches) Length
(meters)

1 10 60

2 10 45

3 12 15

4 12 12

Check pipes and junctions
► Check for any remaining undefined pipes or junctions. If all the pipes and

junctions are defined the Pipe and Junctions group in the Analysis Setup
window will have a green checkmark. If not, turn on the “Show Object Status”
option from the View menu or Workspace Toolbar icon, and open each
undefined pipe and junction. The Status tab on each Properties window will
indicate what information is missing.

Review Model Data
► Save the model one more time. It is also a good idea to review the input using

the Model Data window.

Reviewing input in the Model Data window
The Model Data window is shown in Figure 2.18. To change to this window,
you can click on the Model Data tab, select it from the Window menu, or press
CTRL+M. The Model Data window gives you a table-based perspective of your
model. Selections can be copied to the clipboard and transferred into other
Windows programs, saved to a formatted file, printed to a PDF, or printed out
for review.

Data displays in three sections: the General Data section at the top, the Pipe
Data section in the middle, and the Junction Data section at the bottom. Each
section collapses using the buttons at the top-left of the section. Further, each
section can be resized.

The Model Data window allows access to all Properties windows by double-
clicking on any input parameter cell in the row of the pipe or junction you want
to access.
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Figure 2.18 The Model Data window shows all input in table form

Steady-state groups are now fully defined
The first three groups in Analysis Setup are now fully defined. If desired, the
model could be run in steady-state. The final two groups that need to be defined
are for transient modeling. To run the model in steady-state, go to the
Simulation Mode/Duration panel in Analysis Setup and change the Time
Simulation selection to Steady Only.

In general, it is a good idea to always run your model in steady-state first before
running the full transient analysis to make sure the model is giving reasonable
results.

D. Pipe Sectioning and Output
The next group in Analysis Setup is the Pipe Sectioning and Output group. The
pipes in the model cannot be sectioned until sufficient data in the Fluid
Properties group and Pipe and Junctions group have been specified. The required
data includes the fluid specification (this was done in Step 3B when the Fluid
panel was defined) and all pipe and junction definitions. After these pieces of
data have been entered, the pipes can be sectioned. The Sectioning panel divides
the pipes into computation sections in a manner which is consistent with the
Method of Characteristics (MOC).

Go to the Sectioning panel in Analysis Setup (Figure 2.19). The pipes will
automatically be sectioned and a controlling pipe will be selected. For this
model, the controlling pipe is P4. This is the pipe with the shortest end-to-end
communication time (i.e., L/a – the length divided by the wavespeed). To satisfy
the MOC, the following equation must be applied:
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where n is the number of sections in pipe i, L is the length, and a is the
wavespeed. The Δt is the time step. Since all pipes in the network must be
solved together, the same time step must be used for each pipe. With a given
length and wavespeed for each pipe, it can be seen from the above equation that
it is unlikely that the number of required sections, n, for each pipe will be a
whole number.

To address this situation, it is helpful to recognize that the wavespeed, a, is the
least certain input parameter. It is therefore generally considered acceptable to
allow up to a 15% uncertainty in wavespeed. By adjusting the wavespeed for
each pipe within this tolerance, the sectioning can be made to come out as whole
numbers for each pipe. The Sectioning panel automates this process by
searching for sectioning which satisfies the required tolerance. While a 15%
variance in wavespeed is often acceptable, Impulse uses 10% by default.

Figure 2.19 The Pipe Sectioning panel automates the sectioning process
and calculates the time step

► Open Analysis Setup and go to the Sectioning panel.

The Sectioning panel does not require user input by default. It will automatically
search for the best option for one to five sections in the controlling pipe. The
results will be displayed in the table. If more sections are needed you can change
the Sectioning Mode.

In this example model, the results when the controlling pipe has only one section
shows a maximum variance of about 11%. Since this is greater than the default
10% threshold it was not automatically selected. The option to have two sections
in the controlling pipe is selected since that has the fewest sections with an
acceptable maximum variance.

Note that if the number of sections in the controlling pipe is doubled, the
runtime increases roughly by a factor of four (twice the number of computations
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per time step and twice the number of time steps for the run). In this example,
selecting four sections in the controlling pipe would result in the smallest
variance in wavespeed modifications out of the options displayed, but the
runtime would be four times that compared to the case where two sections are
selected (16 times longer than with one section in the controlling pipe).
Remembering that it is acceptable to have up to a 15% uncertainty in
wavespeed, and that there are other uncertainties in the model, one would
typically pick the option with the fewest sections with an acceptable maximum
variance.

E. Transient Control
The final group to be defined in Analysis Setup before the transient solver can
run is the Transient Control group. This group allows you to specify the time at
which the transient starts and ends, as well as the cavitation and friction model
to use in the calculations.

► Go to the Simulation Mode/Duration panel in Analysis Setup. Enter 2
seconds in the Stop Time field, as shown in Figure 2.20.

The Transient Cavitation panel allows you to enable or disable transient
cavitation modeling and select a model to use. Keep the default selections.

► Click OK to accept the changes in Analysis Setup. All groups in Analysis
Setup should now be defined. The model is ready to be solved.

Figure 2.20 The Simulation Mode/Duration panel offers features to specify
the time span for the transient
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F. Save the model
Saving the model immediately before running it is always a good idea. Ensure
that you save your model now.

Step 4. Run the model
► Choose “Run Model…” from the Analysis menu or click the Run Model

button on the Toolbar. During execution, the Solution Progress window is
displayed and can be used to pause or cancel the Solver's activity (Figure 2.21).

Figure 2.21 The Solution Progress window displays the state of the
simulation

A. The two Solvers
Impulse has two Solvers. The first is called the Steady-State Solver, which as its
name suggests, obtains a steady-state solution to the pipe network. The second
Solver is called the Transient Solver. This solves the waterhammer equations.

Before a transient simulation can be initiated, the initial conditions are required.
These initial conditions are the steady-state solution to the system. After the
steady-state solution is obtained by the Steady-State Solver, Impulse uses the
results to automatically initialize the Transient Solver and then run it.
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When the solution is obtained, click the Output button on the Solution Progress
window to display the table-based Output window. The information in the
Output window can be reviewed visually on the screen, saved to file, exported to
a spreadsheet-ready format, copied to the clipboard, and printed out.

B. The output file
When the Solver runs, the output data is written to a file. This file is given the
same name as the model itself with a number appended to the name, and with an
*.out extension appended to the end. For all data processing, graphing, etc., the
data is extracted from this file. The number is appended because users are able
to build different scenarios all within this model. Each scenario will have its
own output file; thus, the files need to be distinguishable from each other.

The output file will only remain on disk if you save the model after it has
been run. Once saved, it will remain until the user erases it or the model input
data is modified.

► Save the model file again such that the output file is saved to the disk. This
means that if you were to close your model right now and then reopen it, you
could proceed directly to the Output window for data review without rerunning
your model.

Step 5. Review the Output window

The Output window (Figure 2.22) is similar in structure to the Model Data
window. Three areas are shown (including the General section, Pipe Section,
and Junction section), and you can expand or collapse each section by dragging
the boundary between the sections up or down, or by clicking the arrow beside
the section label. The items displayed in the tables are those items you select in
the Output Control window.

The Output window allows you to review both the steady-state and transient
results. The Pipes tab, All Junctions tab, and any specific junction tabs in the
Junction section (such as Branch, Reservoir, Valve, etc.) show the steady-state
results. A summary of the maximum and minimum transient results for each
pipe is given on the Transient Max/Min tab in the Pipe section and is the active
tab displayed in the center section of Figure 2.22.
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Figure 2.22 The Output window displays steady-state and transient
output in tabular form

You can also review the solutions for each time step (i.e., a time history) for
which data was written to file on the Transient Output tab in the Pipe section
(Figure 2.23). Moving the slider along the bottom will change the time step
shown in the table.

The Output Control window (Figure 2.24) allows you to select the specific
output parameters you want to display in your output. You also can choose the
units for the output. If you do not change any of the Output Control settings,
default Output Control parameters and a default title are assigned.
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Figure 2.23 The Output window displays transient data for each time step
in the Transient Output table
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Figure 2.24 Output Control lets you customize the output

A. Modify the output format
If you selected the default Impulse Output Control, the Pipes table of steady-
state results (the tab on the far left in the pipe area) will show volumetric flow
rate in the first column with units of m3/hr (cubic meters per hour).

► Select Output Control from the Tools menu or the main Toolbar. On the
right side of the Pipes section is the list of currently selected output parameters.
Click Volumetric Flow Rate and change the units by clicking the arrow beside
the units, and then selecting m3/sec (cubic meters per second) from the drop-
down list.

► Click OK to display changes to the current results. You should see the
volumetric flow rate results, still in the first column, in units of m3/sec. Notice
the Velocity results in the second column.

► Select Output Control from the Tools menu one more time. The Reorder
scroll bar on the far right allows you to reorder parameters in the list. You may
also reorder parameters by dragging and dropping the icon just to the left of
each parameter within the list of currently selected parameters.

► Select the Velocity parameter and use the Reorder scroll bar to move it up to
the top of the parameter list.

► Click OK to display the changes to the current results. You will see in the
Pipes table that the first column now contains velocity and the second column
contains the volumetric flow rate. The Output Control window allows you to
control the parameters, units and order you prefer in your output. This flexibility
will help you work with Impulse in the way that is most meaningful to you,
reducing the possibility of errors.
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► Lastly, double-click the column header Velocity in the Output window Pipes
Table. This will open a window in which you can change the units once again if
you prefer. These changes are extended to the Output Control parameter data
you have previously set.

Units for each column in the Output section can also be changed by double-
clicking the column header. This will open a window in which you can select
the units again if you prefer (Figure 2.25). These changes are extended to the
Output Control parameter data that is set.

Figure 2.25 The Change Units window is opened from the Output window
tables by double-clicking the column header

Step 6. View the graph results

For transient analyses, the Graph Results window will usually be more helpful
than the Output window because of the more voluminous data.

► Navigate to the Graph Results window by clicking on the Graph Results tab
or pressing CTRL+G. The Graph Results window offers versatile graph
generation and preparation.

Impulse’s Graph Guide feature, accessed by clicking on the “What Would You
Like to Do?” button located at the top-right of the Graph Area, provides
assistance by guiding you through the creation of a “Quick and Simple” graph,
or an “Advanced” graph (Figure 2.26). You can create a graph by following the
prompts on the Graph Guide, or by manually specifying the graphing parameters
on the Graph Control tab on the Quick Access Panel, or from the “Select Graph
Parameters” icon located in the top-left corner of the Graph Results Toolbar. For
the remainder of this Quick Start Guide, the Graph Guide will be hidden, but
keep in mind that you can use it whenever you would like assistance in creating
a graph.

Figure 2.27 shows the Graph Results window with the Graph Control tab
enabled on the Quick Access Panel.
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Figure 2.26 The Graph Guide can be toggled on and off by clicking the
“What Would You Like to Do?” button on the Graph Results
window

Figure 2.27 The Graph Results window and Quick Access Panel Graph
Control tab is where system parameters (both steady-state
and transient) can be graphed

Impulse gives you the ability to create stacked graphs. These are graphs that are
displayed on top of each other with the same x-axis but with different
parameters on the y-axis. This feature is helpful to see how multiple parameters
change in the same location of your model at the same time without having to
create separate graphs.

► Access the graphing parameters by opening the Graph Control tab on the
Quick Access Panel (this tab is automatically selected when the Graph
Results window is opened). Because you are interested in seeing how the
pressures and flows in specific pipe sections respond over time, ensure that the
Transient Pipe tab is selected in the Parameters/Formatting area on the Quick
Access Panel. Alternatively, you can open the Select Graph Parameters window
by clicking on the corresponding icon on the Graph Results Toolbar (this is the
first icon located above the top-left corner of the Graph area).

► Under “Select Pipe Stations” on the Transient Pipe tab, expand the Pipe P3
stations and double-click on Outlet, which is the pipe computing station at the
valve inlet. Alternatively, you can click on the right arrow button after selecting
the pipe station you want to graph to add it to the “Graph These Pipes/Stations”
list. Also add the inlet of Pipe P4 which is the valve exit.
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Note: Once a pipe is broken into sections, computation takes place where the
sections join together, these are called “stations”.

► Select seconds for the Time Units and select “All Times” next to “Time
Frame”.

► In the Parameters definition area, select “Pressure Static” and choose
“barG” in the drop-down box under “Units” to graph the static pressure in
psig at the valve inlet and outlet over time.

► In order to add the stacked graph under the static pressure graph showing
the volumetric flowrate at the inlet and outlet of the J4 Valve, click the
“Add” button, which has the green “+” icon next to “Select Parameter”. A new
row under the Parameter definition area will appear (See Figure 2.28).

► Choose “Volumetric Flowrate Upstream” in this new parameter row and
select units of “m3/hr”.

► Click Generate at the bottom of the Quick Access Panel to create the static
pressure and volumetric flowrate graphs at the inlet and outlet of the valve over
the duration of the simulation.

► To format the legend font size, right-click on a legend and use the scroll bar to
set the font size to 16 for both graphs. Drag the legend to the upper right corner
of the graph.

► To format each axis font size, right click on each axis title and use the scroll
bar to set the size to 20.

Figure 2.28 shows the input in the Parameters/ Formatting area on the Quick
Access Panel.

Figure 2.28 The Graph Control tab on the Quick Access Panel allows you
to specify the graph parameters you want to graph in the
Parameters/Formatting area
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The Formatting area on the Graph Control tab can be used to modify the graph
colors, fonts, and other elements. Options to copy the graph image or x-y data
are available on the Graph Results Toolbar or by right-clicking the graph. The
graph image or x-y data can be saved from the File menu.

Figure 2.29 shows the stacked graphs detailing the static pressures and
volumetric flowrates at the J4 Valve inlet and outlet over two seconds. Here you
can see that the maximum pressure at the valve inlet is about 4 barG. It should
be noted that these graphs could also be made from the Transient Jct tab. In this
case, the inlet and outlet pressures at the valve would be selected separately.

Figure 2.29 Static pressure and volumetric flowrate at the J4 Valve inlet
and outlet are shown over 2 seconds

A. Further review
Further review of the valve graph results in Figure 2.29 shows that at time zero,
the pressure difference between the top and bottom curves of the pressure graph
is about 1.1 barG. This is the steady-state pressure difference across the valve,
which can also be found in the Output window to be 1.096 barG.

As time increases, one sees that the two curves move further apart, which
represents the increased pressure drop across the valve as it closes. At one
second, the valve closes entirely and the pipes upstream and downstream of the
valve are isolated from each other and will decay to the steady-state conditions
which exist for a closed valve.

For the purpose of analysis, it would also be useful to view the volumetric
flowrate from each supply tank over time.

► Create a new graph tab by clicking the “New Tab” button which is the green
plus icon (+) located on the bottom-right, immediately below the graph area
(Figure 2.30).
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► Open the Transient Pipe tab on the Graph Control tab of the Quick Access
Panel. Add the P1 and P2 inlet pipe stations to the “Graph These Pipes/Stations”
list and remove P3 outlet and P4 inlet pipe stations.

► Select “seconds” in the Time Units section and “All Times” in the Time
Frame section to graph the volumetric flowrate over the entire simulation
duration.

► Select Volumetric Flowrate Upstream and specify the units as “m3/hr”.
Remove the Pressure Static parameter by selecting the row and clicking the
Remove button.

► Click the Generate button to display the graph. A graph of these stations shows
the flowrates out of the two supply reservoirs. Note that after the valve closes,
the fluid in the J1 Reservoir flows to the J2 Reservoir (Figure 2.30).

Figure 2.30 Transient flowrates out of the reservoirs

Note: Impulse allows you to quickly generate several types of graphs by right-
clicking on pipes or junctions on the Workspace after your model has output. To
quickly generate the static pressure plot at the J4 Valve inlet and outlet, you can
right-click on the J4 Valve on the Workspace, then select “Generate Transient
Graph for Pipes”, then select Pressure Static. To add the volumetric flowrate
stacked graph, or to modify any units or other graph parameters, access the
Graph Control tab on the Quick Access Panel and adjust the graph parameters as
desired.
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Step 7. View the Workspace Layers

Workspace Layers can display input and output data values superimposed over
the graphical model layout. They can also overlay additional graphical
modifications, animations, and customize the appearance of objects in the
model. The displayed data can be organized on one or more layers which can be
toggled on or off, allowing flexibility for viewing results in a graphical manner.

► Navigate to the Workspace window by clicking on the Workspace tab or
pressing CTRL+W. Select the Workspace Layers tab in the bottom-right of the
Quick Access Panel. The Workspace Layers panel contains two sections named
Layer Presets and Layers.

Within the Layers section, there are two layer groups named Advanced Layers
and Standard. We will integrate the model results with the graphical layout of
the pipe network by using a Standard layer. All models must have at least one
Standard layer, so by default there will be a "Layer 1" automatically created. It
will contain all objects in the model (pipes, junctions, annotations, etc);
however, objects can be hidden if desired, or the visibility of the entire layer
itself can be toggled on/off using the eye icon next to the layer. When additional
layers are created they will stack on top of each other, with the layers on top
taking precedence over others below. The combination of layers and toggling
visibility allows for a wide range of visual customization.

► Open the Layer Settings window for Layer 1 by double-clicking the layer.
The Layer Settings window is shown in Figure 2.31.

The Layer Settings window provides flexible options for customizing the
appearance of the model. The Pipes & Junctions group allows you to show or
hide junctions, and change display properties like color, size, and thickness. The
Label Control group allows you to display input and output parameters next to
objects on the Workspace. The Annotations group allows you to customize
annotations.
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Figure 2.31 The Layer Settings window specifies content to be
superimposed on the Workspace

► Select the Pipe Parameters item under the Label Control group. The left
pane lists input and output parameters available for display, and the right pane
lists the parameters currently being displayed by the layer on the Workspace.

► In the left pane, expand the Pipe Max/Min Parameters list. Then, select Max
Pressure Stagnation in the list with units of barG. Add it to the right pane by
either double-clicking the parameter, or selecting the parameter and clicking the
arrow between the panes. Repeat the process to add the Min Pressure Stagnation
parameter.

► Add additional clarity by repositioning the labels and adding a legend. It is
common for the text on the Workspace Layers to overlap with objects when first
generated. Labels can be dragged to a new area or a smaller font can be selected
using the Font Decrease icon on the Workspace Toolbar or from within the
Global Layer Settings. Parameter units can be consolidated in a legend which
can be added via the Global Layer Settings. In the Layers Toolbar, click the
double gear icon to open the Global Layer Settings. Then, enable the checkbox
for Show Units in Legend. The result of these adjustments is shown in Figure
2.32.
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Figure 2.32 Results are superimposed on the model layout via Workspace
Layers

The Workspace Layers also provides the ability to animate the transient results
as a qualitative tool to visualize the behavior in a network. This option can be
accessed from the Color Maps/Animations layer type.

► Create a new Color Map/Animation layer using the green plus icon (+) on the
Layers Toolbar in the Quick Access Panel.

► Open the Layer Settings window and select the Animation option under the
Layer Type. The other Standard Workspace Layers will be visible, but only one
Advanced Layer can be shown at a time. Only one parameter can be animated at
a time. The parameter can be animated using absolute values, values relative to
the steady-state, or a static map of all maximum/minimum transient values can
be generated.

► Select Pressure Static as the parameter for the animation using units of
barG. The model setup for animating static pressure can be seen in Figure 2.33.

► Close the Layer Settings and add additional clarity by repositioning the
legend and time counter. By default the legend will be drawn in the top-left
corner of the Workspace. You can click and drag the legend and time counter to
new positions on the Workspace.

► Watch the animation by clicking Play on the animation playback controls at
the top of the Workspace. The sliders and plus/minus icons can be used to skip
to a different time step or increase the playback speed. The animation can be
saved to a file using the Record button.
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Figure 2.33 Workspace Layers provides an animation feature as an
alternate way to view the transient results

Conclusion

You have now used Impulse's Primary Windows to build a simple waterhammer
model. The maximum pressure at the valve’s inlet during this valve closure was
approximately 4.1 barG.
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C H A P T E R 3

Pump Startup with Event Transients

This example looks at three pump startup cases for a water transfer system. The
objective is to determine the maximum pressures in the system and to assess
whether the system cavitates or experiences sub-atmospheric pressure.

Topics covered
� Starting one or more pumps

� Using steady-state and transient special condition features

� Using event transients

� Using the Scenario Manager

� Adding Graphs to the Graph List Manager

� Using animation features

Required knowledge

This example assumes that the user has some familiarity with Impulse such as
placing junctions, connecting pipes, and entering pipe and junction properties.
Refer to the example in Chapter 2 for more information on these topics.

Model file

A completed version of the model file can be referenced from the Examples
folder as part of the Impulse installation:

C:\Users\[username]\Documents\Datacor\Impulse 11\Examples
� Metric - Pump Startup with Event Transients.imp

Problem statement

This problem contains two pumps in parallel that transfer water from a supply
reservoir to two process tanks downstream. The following three different pump
startup scenarios are to be modeled and evaluated:
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1. Both pumps starting

2. One pump starting

3. One pump starting with the other pump already running

As the design engineer, you will evaluate these three scenarios to determine the
maximum and minimum system pressures, as well as use the animation features
in Impulse to understand how the system will respond in each case.

Step 1. Define the Fluid Properties group
1. Open Analysis Setup using the button on the Common Toolbar or from the

Analysis menu.
2. Open the Fluid panel, select the Impulse Standard library, then select Water

(liquid) from the “Fluids Available in Library” list.
3. Click “Add to Model” to select water for use in this model.

4. Enter 16 deg. C in the Temperature field. This calculates the fluid
properties to use in the model.

5. Click OK.

Note: The fluid can also be specified in the Startup window when Impulse is
first opened.

Step 2. Define the Pipes and Junctions group

At this point, the first two groups are completed in Analysis Setup. The next
group is the Pipes and Junctions group.

A. Place the pipes and junctions
In the Workspace window, assemble the model as shown in Figure 3.1. The

Add/Remove Segments button on the Toolbar can be used to create the bend in
pipes P4 and P6, or you can select the pipe and use the keyboard shortcut
CTRL+SHIFT+Y. Segments are only visual, and do not affect calculations.

Figure 3.1 Layout of pipe system for pump startup example
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B. Enter the pipe and junction data
The system is in place, but now the input data for the pipes and junctions needs
to be entered. Double-click each pipe and junction and enter the following data
in each Pipe and Junction Properties window.

Pipes
All pipes are Steel – ANSI, STD, Thick-Walled Anchored Upstream, and
Standard Friction Model with the following properties:

Pipe Name Size
(inches)

Length
(meters)

1 Suction Pipe Pump #1 10 15

2 Discharge Pipe Pump #1 10 6

3 Pipe 10 6

4 Suction Pipe Pump #2 10 18

5 Discharge Pipe Pump #2 10 6

6 Pipe 10 6

7 Pipe 16 30

8 Line to Process #1 Tank 12 76

9 Line to Process #1 Tank 12 61

10 Line to Process #1 Tank 12 366

11 Line to Process #2 Tank 12 1524

J1 - Reservoir
1. Name = Supply Reservoir

2. Tank Model = Infinite Reservoir

3. Liquid Surface Elevation = 6 meters

4. Liquid Surface Pressure = 0 barG

5. Pipe Depth = 6 meters

J10 - Reservoir
1. Name = Process #1 Tank

2. Tank Model = Infinite Reservoir

3. Liquid Surface Elevation = 30 meters

4. Liquid Surface Pressure = 0 barG

5. Pipe Depth = 3 meters
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J11 - Reservoir
1. Name = Process #2 Tank

2. Tank Model = Infinite Reservoir

3. Liquid Surface Elevation = 3 meters

4. Liquid Surface Pressure = 0 barG

5. Pipe Depth = 3 meters

J6, J7, & J8 - Branches
1. Elevation = 0 meters

J2 & J4 - Pumps
1. J2 Name = Transfer Pump #1

2. J4 Name= Transfer Pump #2

3. Inlet Elevation = 0 meters

4. Pump Model = Centrifugal (Rotodynamic)

5. Enter Curve Data =

Volumetric Head

m3/hr meters

0 45.7

227 42.7

454 36.6

6. Curve Fit Order = 2

7. Click Generate Curve Fit Now, then click OK

8. Click the Transient tab

9. Transient = Speed vs. Time

10. Transient Data = Absolute Values

Time
(seconds)

Pump Speed
(Percent)

0 0

2 100

10 100

11. Click the Optional tab

12. Special Condition = Pump Off With Flow Through
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Note: The pump special condition indicates that initially the pump is turned off,
but flow can go through it during steady-state. Valve junctions will be used to
prevent any steady-state flow, as mentioned earlier. The pump junction on the
Workspace will now have a red ‘X’ next to it indicating that the special
condition is set to closed.

J3 & J5 - Valves
1. J3 Name = Valve #1

2. J5 Name = Valve #2

3. Inlet Elevation = 0 meters

4. Set the “Loss Source” to “User Specified”

5. Set the “Loss Model” to “Cv”

6. Cv = 1000

7. Click the Transient tab

8. Transient Data = Absolute Values

Time (seconds) Cv

0 0

1 800

2 1000

10 1000

7. Click the Optional tab

8. Special Condition = Closed

Note: When you close the valves, the adjacent pipes are displayed with dashed
lines to denote that the pipes will have no flow.

J9 - Valve
This valve will use an event transient. This means that the time zero in the
Transient Data table is with respect to a condition occurring in the system. If the
condition is never reached, the valve transient never initiates. Here, the valve
should open when the pressure at Branch J7 is sufficient for water to flow into
Reservoir J10. There is no "Junction Pressure" for the "Initiation of Transient",
but there is one for pipes. Use one of the pipes connected to Branch J7 as a basis
for the event.
1. Name = Valve to Process #1 Tank

2. Inlet Elevation = 0 meters

3. Set the “Loss Source” to “User Specified”

4. Set the “Loss Model” to “Cv”
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5. Cv = 500

6. Click the Transient tab (Figure 3.2)

7. Initiation of Transient = Single Event

8. Event Type = Pressure Stagnation at Pipe

9. Condition = Greater Than

10. Value = 3.1 barG

11. Pipe = 7 (Pipe) Outlet

12. Transient Data = Absolute Values

Time (seconds) Cv

0 0

2 400

3 500

10 500

Figure 3.2 Specifying an event transient for Valve J9

47 Impulse 11 Quick Start Guide



11. Click the Optional tab

12. Special Condition = Closed

Note: Transients which have multiple event initiators can be defined using
Multi-Condition events, which are defined by selecting Multi-Condition for the
Event Type, then using the Multi-Condition Event Manager to group the events.

C. Check if the pipe and junction data is complete
Turn on “Show Object Status” from the toolbar or View menu to verify if all
data is entered. If so, the Pipes and Junctions group in Analysis Setup will have
a check mark. If not, the pipe or junction number of any uncompleted pipes or
junctions will be shown in red. If this happens, go back to the uncompleted
pipes or junctions and enter the missing data.

Note: Red is the default color that shows what objects are undefined in your
model when Show Object Status is active. This color is configurable in the User
Options.

Step 3. Review the Pipe Sectioning and Output group

Open Analysis Setup and go to the Sectioning panel. By default, the best
sectioning scheme will be automatically calculated and selected. This is
determined by searching for the minimum number of sections in a controlling
pipe that will satisfy a maximum wavespeed variance of 10%. The sectioning
parameters will be displayed in the table. Keep the default selection of the
Automatic sectioning mode.

Navigate to the Output Pipe Stations panel. Ensure that all pipes are set to save
all stations to the output file. This is the default behavior, but it could differ due
to a setting in your User Options. If the pipes are not set to All Stations, then
this can be quickly done in bulk by clicking the All button below the list, setting
the Change Selected Pipes To drop-down to All Stations, and clicking the
Change Selected Pipes To button. This will be useful later for animation
purposes.
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Figure 3.3 Output Pipe Stations panel with All Stations selected for all
pipes

Step 4. Specify the Transient Control group

Click the Simulation Mode/Duration panel in the Transient Control group and
enter a Stop Time of 10 seconds.

Next, go to the Transient Cavitation panel and select the No Cavitation option.

Step 5. Create scenarios to model the three startup cases

In this model, the following three pump startup cases are to be evaluated:
1. Both pumps starting

2. One pump starts while the other pump stays off

3. One pump starts while the other is already running

Three scenarios need to be created to model the three cases.

A. Create scenarios
The Scenario Manager is a powerful tool for managing variations of a model,
referred to as scenarios. The Scenario Manager allows you to:
� Create, name, and organize scenarios

� Select the scenario to appear in the Workspace (the current scenario)

� Delete, copy, and rename scenarios

� Duplicate scenarios and save them as separate models
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� Review differences between scenarios using the Scenario Comparison Tool

� Propagate changes from a parent scenario to its children

You will create three scenarios to model these cases. Access the Scenario
Manager from the Quick Access Panel, which is located on the right side of the
Workspace area, or from the Tools menu. A scenario tree displays all model
scenarios.

► Click the “Create Child” button on the Scenario Manager on the Quick
Access Panel. Name the child “Two Pump Start.” A new scenario will appear
below the Base Scenario in the scenario tree. Select the Base Scenario, create
another child, and call it “One Pump Start.” Finally, select the Base Scenario,
and create a third child called “One Pump Start With One Running” (see Figure
3.4). Note that the new child scenario is loaded when it is created using the
Scenario Manager on the Quick Access Panel.

Figure 3.4 Create model variants and keep them organized using the
Scenario Manager on the Quick Access Panel

B. Set up scenarios
Child scenarios “inherit” data from their ancestors. As long as the data has not
been modified in a child scenario, data parameters in the child scenario will have
the same value as their parent.

Two Pump Start
Since the Base Scenario already has been set up with two pumps starting, the
“Two Pump Start” child does not need to be modified.

One Pump Start
Double-click the “One Pump Start” scenario in the scenario tree. This will load
the “One Pump Start” scenario onto the Workspace as the current scenario. The
currently loaded scenario is displayed in the scenario tree with a green check
mark (Figure 3.4).

Here, only Pump J2 will be started while keeping Pump J4 off. Deleting the
transient input data for Pump J4 and Valve J5 will keep these two junctions
turned off because their Special Conditions specify that they are off.
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Alternatively, their transient data can be set to be ignored. The second option is
what will be done here.

► Open the J4 Pump Properties window. Click on the Transient tab, then choose
the “Ignore Transient Data” option in the “Transient Special Condition” area as
shown in Figure 3.5, then click OK. Note that a red ‘#’ will now be shown next
to Pump J4 indicating that the transient data is ignored. Do the same with Valve
J5. The required input for this scenario is now complete.

Figure 3.5 Transient Special Condition section on the Transient tab of
the Pump Properties window

One Pump Start with One Running
Double-click the “One Pump Start With One Running” scenario from the
scenario tree. This will load the “One Pump Start With One Running” scenario
onto the Workspace as the current scenario. This step can also be accomplished
by opening the Scenario Manager from the Tools menu, selecting the “One
Pump Start With One Running” scenario in the scenario tree and then clicking
the “Load As Current Scenario” button.

Here, Pump J2 will be running at 100% speed during the steady-state and
transient, and Pump J4 will be started.

► Open the J2 Pump window and select the Optional tab. Set the Special
Condition to “None”. This specifies that during the steady-state the pump will be
on and operate on its curve.

► Select the Transient tab and set the Transient Special Condition to “Ignore
Transient Data”, since this pump will run at 100% speed during the transient.
Alternatively, the speed data could be deleted.

The Special Condition for Valve J3 also needs to be set to “None”, and the
Transient Special Condition on the Transient tab set to “Ignore Transient Data”
by following the two steps above in the J3 Valve Properties window. The
required input for this scenario is now complete.
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Step 6. Run the model

Load the "Two Pump Start" scenario. All groups in Analysis Setup should now
be complete and the model is ready to run. Run the model by pressing the “Run
Model” icon on the Common Toolbar, selecting “Run Model” in the Analysis
menu, or pressing CTRL+R on the keyboard. This will open the Solution
Progress window. When complete, press the “Graph Results” button.

Step 7. Graph the results

First, a profile graph will be created to show the static pressure across the length
of a series of pipes.

A. Create a profile graph
1. From the Graph Control tab on the Quick Access Panel, select the Profile

tab.
2. Select pipes 1, 2, 3, 7 and 11 to specify the path from the supply reservoir

to Reservoir J11. Alternatively, you can select all these pipes on the
Workspace by holding SHIFT while clicking on all pipes in the path, then
return to the Graph Results tab and select “Workspace” to automatically
choose all pipes currently selected on the Workspace.

3. Use “meters” for the Length Units.

4. In the Parameters definition area, use “Pressure Static” and specify “barG”
in the dropdown box under “Units”.

5. Ensure that the boxes in the Mx and Mn columns are selected (these
indicate that your graph will display the maximum and minimum pressures,
respectively).

6. Click Generate.

Results (shown in Figure 3.6) indicate that the peak pressure occurs at the pump
discharge, and that the minimum pressure is above atmospheric pressure at all
times.
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Figure 3.6 Profile of the maximum and minimum pressures through
Pump #1 to Process #2 Tank for the Two Pump Start scenario

To easily recreate this graph in other scenarios or in the future, it can be added
to the Graph List Manager. After generating the graph, click the “Add Graph To
List” button on the Graph Results Toolbar (this icon is a blue “+” sign on top of
a file folder image). Give the graph a name like “Pressure Profile Pump #1 to
Process #2 Tank”. The graph will be added to the currently selected folder in the
Graph List Manager. Note that graphs added to the Graph List Manager are not
permanently saved until the model itself is saved again.

The profile through the other flow paths (there are four paths altogether) can
also be plotted, and similar conclusions are obtained. Add the other three paths
to the Graph List.

B. Create a Transient Junction graph
Since the maximum pressure is at the pump discharge, it is of interest here to
plot the pressure vs. time. The volumetric flowrate vs. time at the pump
discharge is also of interest. You will use Impulse’s dual y-axis graphing
abilities to plot both the pressure and volumetric flowrate vs. time on the same
graph to observe how the pressure and flow change at the same time.
1. From the Graph Control tab, choose the Transient Jct tab in the

Parameters/Formatting area and add pumps J2 and J4 to the “Graph These
Junctions” list.

2. Ensure that the Time Units is set to “seconds” and the Time Frame is set to
“All Times”.
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You will need to decide what parameter you wish to plot on the primary y-axis
and which parameter you want to plot on the secondary y-axis. In this example,
we will plot pressure on the primary y-axis and volumetric flowrate on the
secondary y-axis.
3. To do this, select “Pressure Static Outlet” in the Parameters definition area

and choose “barG” as the units.
4. Add a parameter by clicking on the “Add” button next to “Select

Parameter” in the Parameter definition area.
5. Change this added parameter to “Vol. Flow Rate Outlet” and choose

“m3/hr” as the units.
6. To specify that the volumetric flowrate will be plotted on the secondary y-

axis, click the “Make Secondary Y-Axis” button, which is the blue, right
arrow icon located to the top-right over the selected parameters.
Alternatively, you can double-click on the column in front of “Vol. Flow
Rate Outlet” in the Parameter definition area. Note that “Vol. Flow Rate
Outlet” becomes indented under “Pressure Static Outlet”, and that the black
arrow next to “Vol. Flow Rate Outlet” turns to point towards the graph. See
Figure 3.7 to see how these graphing parameters are defined.

Figure 3.7 Parameter definitions for a dual y-axis graph of static
pressure (primary y-axis) and volumetric flowrate (secondary
y-axis) on the Graph Control tab on the Quick Access Panel

Click Generate. You will see that the transient pressures at the pump discharge
are plotted versus time on the primary y-axis, and the volumetric flowrate vs.
time is plotted on the same graph on the secondary y-axis. As would be
expected, the pressure and volumetric flowrate transients are very similar for
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both pumps. The resulting graph is shown in Figure 3.8. Add this graph to the
Graph List Manager with the name “Pump Discharge Pressures & Flows”.

Figure 3.8 Pressure and volumetric flowrate transients at both pump
discharge locations for the Two Pump Start scenario

C. Create a Transient Pipe graph
The flowrates into the two process tanks are of interest.
1. Go to the Transient Pipe tab on the Graph Control tab.

2. Add the outlet of Pipes P10 and P11 from the “Select Pipe Stations” list to
the “Graph These Pipes/Stations” list.

3. Select “Volumetric Flowrate” from the Parameter list.

4. Choose units of m3/hr.

5. Click Generate.

Results are shown in Figure 3.9. Add this graph to the Graph List Manager with
the name “Process Tank Flow Rates”.
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Figure 3.9 Flowrate transient at both process tanks for the Two Pump
Start scenario

Step 8. Animate the results

Impulse can animate hydraulic parameters along pipeline paths in your model in
the Graph tab. This feature is very helpful when trying to understand how your
system will respond when a transient event occurs. You can also animate
multiple graphs at the same time.

Here, you will animate the pressure and volumetric flowrate responses along the
path you previously graphed to gain an understanding of how these hydraulic
parameters respond as the pumps start up. To animate these parameters:
1. Load the Graph List item you previously created for the pressure profile by

double-clicking the graph name in the Graph List Manager (Pressure
Profile Pump #1 to Process Tank #2).

2. Make sure pipes 1, 2, 3, 7, and 11 are selected.

3. Make sure the Length Units are meters.

4. Next to “Animate Using”, specify “Output”, and specify “seconds” next to
Animation Time Units (see the following paragraph for an explanation
about this option).

5. Uncheck the boxes for Mx and Mn so that the maximum and minimum
values will NOT be displayed (See Figure 3.10).
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To use the “Animate Using: Output” option for animation, all pipe stations need
to be specified to be saved in the Output Pipe Stations panel in the Pipe
Sectioning and Output group (this was done previously in Step 4). This
animation option has the most flexibility to start, pause, speed up, skip
forward/backward, and restart the animation.

Another animation option in Figure 3.10 is “Animate Using: Solver”. This
option re-runs the Transient Solver to generate the data for animation, and thus
does not need to read it from the output file. Therefore, it does not require all of
the pipe station data to be saved in Transient Control. However, it cannot be
sped up or skipped forward due to the calculations happening in real time.

Figure 3.10 Selecting animation in Graph Results for the Two Pump Start
scenario

Click Generate. Additional animation control features appear on the Graph
Results window (Figure 3.11). Press the Play button and watch the pressure
waves move. Add this graph to the Graph List Manager with the name
“Animated Pressure Profile”.
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Figure 3.11 Animating output in Graph Results for the Two Pump Start
scenario

There is also animation available via the Workspace Layers, which can be useful
to see how the flow paths interact with each other.

► Go to the Workspace window and select Workspace Layers in the Quick
Access Panel. Select New Layer, indicated by the green plus sign in the Layers
section. Select Color Map/Animation and give the New Layer a name such as
Static Pressure Animation. Open up the Layer Settings with the gear icon.

► Set the Layer Type to Animation and specify the following settings (Figure
3.12):
1. Data Type = Absolute Values

2. Smooth colors between pipe sections = Checked

3. Parameter = Pressure Static

4. Units = barG

Close the Layer Settings. The Animation should now be visible on the
Workspace. Note that the animation toolbar again appears, similar to when using
Graph Animation.

► Press the Play button to watch the pressure transients in the system.
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Figure 3.12 Workspace Animation Settings

Figure 3.13 Workspace Animation

Step 10. Run the other scenarios and graph the results

Using Scenario Manager, load the other two scenarios and run them. Reload the
Graph List items that were previously saved for the new scenarios by double-
clicking the graph names in the Graph List Manager. This will reveal that the
maximum pressure for the “One Pump Start” scenario occurs at the pump
discharge location, similar to the first scenario, but in the “One Pump Start With
One Running” scenario, the maximum pressure occurs in Pipe P11 (between J7
and J11 on the graph). This can also be seen from the Transient Max/Min tab of
the Pipe Output section on the Output Primary Window. Also, the pressure
drops below atmospheric pressure, but does not reach the vapor pressure of
water (-0.995 barG).

In the “One Pump Start With One Running” scenario, it should also be noted
that there is a warning given for the pump. This is indicated by the red message
in the status bar that reads “Warnings Exist”. The warning can be viewed in the
top third section of the Output window on the Warnings tab, and states that there
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was reverse flow at Pump J4. This warning message indicates that there was
insufficient information available to accurately calculate the pump head with
backwards flow. It is recommended to adjust the model to better account for this
flow.

Depending on the system, there are several actions that may be appropriate. One
change may be to adjust model inputs such as the discharge valve opening
profile to prevent reverse flow to the pump. This is only acceptable if the
changes are physically accurate for the system. Otherwise, it will be necessary to
choose an appropriate four quadrant data set for the pump to accurately predict
the head at reverse flow conditions. This will be discussed further in the next
chapter.

Conclusion

The numerical maximum static pressure during the transient can be found at the
bottom of the General data section in the Output window of each scenario and is
summarized in Table 3.1 for all three scenarios. For these cases, the maximum
pressures do not significantly differ from each other.

Table 3.1 Summary of maximum transient static pressure for the three
scenarios

Case
Max. Static
Pressure

(bar)

Two Pumps
Start 6.028

One Pump
Start 5.944

One Pump
Start With
One On

6.079
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C H A P T E R 4

Pump Trip Example

This example evaluates two parallel pumps tripping in a cooling tower system.
Various discharge valve closure times are analyzed to examine the impact on the
system when the valves close quickly enough to prevent reverse flow at the
pump, and when the valves do not close completely before reverse flow occurs
in the pump.

Topics covered
� Specifying a pump curve and power curve

� Using one of the transient pump inertia models

� Using Four Quadrant Data to model reverse flow and reverse rotation in the
pump

Required knowledge

This example assumes that the user has some familiarity with Impulse such as
placing junctions, connecting pipes, and entering pipe and junction properties.
Refer to the example in Chapter 2 for more information on these topics.

Model file

A completed version of the model file can be referenced from the Examples
folder as part of the Impulse installation:

C:\Users\[username]\Documents\Datacor\Impulse 11\Examples
� Metric - Pump Trip with Four Quadrant Modeling.imp

Problem statement

In this problem, two parallel pumps in a cooling tower system lose power,
causing the pumps to trip. It is desired for the valves at the discharge of the
pumps to close quickly enough to prevent reverse flow and rotation in the
pumps. You will evaluate the maximum and minimum pressures experienced in
the system during this pump trip event.
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Furthermore, you will look at the case where the minimum valve closure time is
12 seconds, in which case reverse flow and rotation will occur at the pump.

Step 1. Define the Fluid Properties group
1. Open Analysis Setup using the button on the Common Toolbar or from the

Analysis menu.
2. Open the Fluid panel, select the Impulse Standard library, then select Water

(liquid) from the “Fluids Available in Library” list.
3. Click “Add to Model” to select water for use in this model.

4. Enter 38 deg. C in the Temperature field. This calculates the fluid
properties to use in the model.

5. Click OK.

Step 2. Define the Pipes and Junctions group

At this point, the first two groups are completed in Analysis Setup. The next
group is the Pipes and Junctions group.

A. Place the pipes and junctions
In the Workspace window, assemble the model as shown in Figure 4.1.

Figure 4.1 Layout of the cooling tower system
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B. Enter the pipe and junction data
The system is in place, but now the input data for the pipes and junctions needs
to be entered. Double-click each pipe and junction and enter the following data
in each Pipe and Junction Properties window.

Pipes
All pipes are Steel - ANSI, STD Type, Standard Friction Model, with Thick-
Walled Anchored Upstream Pipe Support.

Pipe Name Size
(inches)

Length
(meters)

1 Pipe 18 12

2 Pipe 18 12

3 Main Supply 30 99

4 Main Return 30 11

5 CWP-1 Suction 20 3

6 CWP-1 Discharge 20 3

7 Pipe 20 3

8 CWP-2 Suction 20 3

9 CWP-2 Discharge 20 3

10 Pipe 20 3

11 CT Return 30 122

12 Pipe 20 12

13 Pipe 20 12

J1 & J2 - Reservoirs
1. J1 Name = CT #1 Basin

2. J2 Name = CT #2 Basin

3. Tank Model = Infinite Reservoir

4. Liquid Surface Elevation = 12 meters

5. Liquid Surface Pressure = 0 barG

6. Pipe Depth = 1 meters

J3 - Branch
Elevation = 11 meters
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J4 - General Component
1. Name = Surface Condenser

2. Inlet Elevation = 0 meters

3. Loss Model = Resistance Curve

4. Enter Curve Data =

Volumetric Head

m3/hr meters

0 0

4542 6.7

9085 26.8

5. Curve Fit Order = 2

6. Click Generate Curve Fit Now, then click OK

J5 & J10 - Branches
Elevation = 0 meters

J11 - Branch
Elevation = 15 meters

J6 & J8 - Pumps
1. J6 Name = CWP-1

2. J8 Name = CWP-2

3. Inlet Elevation = 0 meters

4. Pump Model = Centrifugal (Rotodynamic)

5. Performance Curve Used in Simulation = Standard Pump Curve

6. Enter Curve Data =

Volumetric Head Power

m3/hr meters kW

0 34.1 78.3

454 32.9 96.9

908 31.7 119.3

1363 29.9 141.6

1817 27.4 156.5

2271 23.8 164
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Volumetric Head Power

m3/hr meters kW

2825 18.3 156.5

7. Curve Fit Order = 2

8. Click Generate Curve Fit Now, then click OK

9. Rated Pump Speed = 1790 rpm

10. Click the Transient tab

11. Transient = Trip (With Inertia)

12. Initiation of Transient = Single Event

13. Event Type = Time Absolute

14. Condition = Greater Than or Equal To

15. Value = 0 seconds

16. Total Rotating Inertia = User Specified

17. Value = 5.9 kg-m2

Note: When reverse flow occurs at the pump, the Four Quadrant Model is
recommended to obtain a better estimate for the head at reverse flow. To
simplify the input, we will define the pump with the Standard Pump curve for
now (Figure 4.2). We will come back later and compare these results to the Four
Quadrant option.
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Figure 4.2 Pump Model tab for Pump J6 where the pump behavior with
forwards and backwards flow can be seen in the Flow
Directional Behavior section

J7 & J9 - Valves
1. Inlet Elevation = 0 meters

2. Loss Source = User Specified

3. Loss Model = Cv

4. Cv = 10,000

5. Click the Transient tab

6. Transient Data =

Time (seconds) Cv

0 10,000

3 1,000

5 0

15 0
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J12 & J13 - Spray Discharges
These junctions each represent numerous spray nozzles that are modeled as a
single nozzle for simplicity.
1. J12 Name = CT #1

2. J13 Name = CT #2

3. Elevation = 24 meters

4. Loss Model = Cd Spray (Discharge Coefficient)

5. Geometry = Spray Nozzle

6. Exit Pressure = 0 barG

7. Cd = 0.6

8. Discharge Flow Area = 0.18 meters2

C. Check if the pipe and junction data is complete
Turn on “Show Object Status” from the toolbar or View menu to verify if all
data is entered. If so, the Pipes and Junctions group in Analysis Setup will have
a check mark. If not, the pipe or junction number of any uncompleted pipes or
junctions will be shown in red. If this happens, go back to the uncompleted
pipes or junctions and enter the missing data.

Step 3. Define the Transient Control group

Go to the Simulation Mode/Duration panel in the Transient Control group and
enter a Stop Time of 15 seconds. Next, in the Save Output To File section,
change the selection to Every 10 Time Steps to reduce runtime.

Step 4. Run the model

All groups in Analysis Setup should now be complete and the model is ready to
run. Run the model by either pressing the Run Model icon on the Common
Toolbar, selecting Run Model in the Analysis menu, or pressing the CTRL+R
keyboard shortcut. This will open the Solution Progress window. When
complete, press the Output button.

Step 5. Review results

A warning is given in the output for each pump stating that the pump
experienced reverse flow and was using a Standard Pump Curve, meaning that
the zero flow head value was used to predict head and power at reverse flow. In
general, if the reverse flow is low in magnitude and duration, then using the
zero-flow head may be a reasonable approximation and the warning could be
dismissed. We will examine the impact of using a four quadrant curve as
suggested by this warning later in this example.
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A. Graph the pump speed decay
1. Change to the Graph Results window.

2. On the Transient Junction tab, add Pump J6.

3. In the Parameter definition area, choose Speed as the parameter.

4. Choose Percent in the Units column.

5. Click Generate.

6. Click the Add Graph to List button from the Toolbar to save this graph to
the Graph List Manager so that it can be regenerated later, and name it
“Speed vs. Time”.

The speed of the two pumps should decay similarly. Figure 4.3 shows the speed
decay for CWP-1. Here the pump speed decays quickly at first, then begins to
slow after the discharge valve closes at about 5 seconds.

Figure 4.3 The pump speed decay is shown, where the speed decays
quickly at first, and then slows down after the valve closes
and the flow goes to zero

B. Graph the transient pressures and flows at the pump station
1. Return to the Graph Control tab on the Quick Access Panel.

2. Go to the Transient Pipe tab on the Graph Control tab and add Pipe P5
Outlet and Pipe P7 Inlet under the Graph These Pipes/Stations list. These
locations represent the pump suction and valve discharge piping,
respectively.

3. Select the Time Units as seconds and ensure that the Time Frame is
showing All Times.

4. Add a second parameter to be graphed by clicking on the Add button,
represented with the green “+” icon. Select Pressure Static as one parameter
to be graphed and Volumetric Flowrate as the second parameter to be
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graphed.
5. Move the Volumetric Flowrate to the secondary y-axis by clicking the

Make Secondary Y-axis button, which is the blue, right arrow icon, or by
double-clicking in the column to the left of the parameter. This parameter
should now be indented.

6. Set the units to barG for the static pressure and m3/hr for the volumetric
flowrate.

7. Click Generate.

8. Add the graph to the Graph List Manager with the name “Pressure &
Flowrate vs. Time”.

In Figure 4.4 you can see that initially the pressure increases at the pump inlet
and decreases at the valve outlet, but later on the pressures begin to oscillate
once the discharge valve becomes fully closed.

Figure 4.4 Pressure and volumetric flow rate transients using the
standard pump curve data

Step 6. Create additional pump scenarios

To check the validity of our results when using the standard pump curve to
perform the pump trip with inertia, we should now go back and run the model
with the pumps specified using four quadrant data for comparison. We will
create three child scenarios, one for the current pump configuration using the
Standard Pump Curve, and two using a Four Quadrant Data Set.

To do this, click the Create Child button on the Scenario Manager on the Quick
Access Panel. Name the child “Standard Pump Curve”. A new scenario will
appear below the Base Scenario in the scenario tree. Select the Base Scenario,
create another child, and call it “Four Quadrant BEP”. We will later clone this
scenario to create our third child scenario.
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The “Standard Pump Curve” Scenario will use the pump settings that were
already defined, so no changes will be needed for this scenario.

A. Four Quadrant BEP
Load the “Four Quadrant BEP” scenario by double-clicking the name in the
Scenario Manager. Open the Pump Properties window for Pump J6.
1. Select the option for Four Quadrant Curve (Figure 4.6).

2. Under the Four Quadrant Curve option click User Selected, and click
Specify Model.

3. Impulse provides multiple pre-defined Four Quadrant Data sets which are
characterized by specific speed. To choose a data set to use, we will first
estimate the specific speed for the pump, which Impulse will use to
recommend a data set. To do this, click Suggest a Data Set under Four
Quadrant Data Set.

4. By default, Impulse will select Calculated from Standard Pump Curve,
which allows most of the data to be automatically populated from the Pump
Properties window. In this case the predefined data is accurate for the
pump, so click Calculate.

Figure 4.5 Four Quadrant Model settings

5. The specific speed is estimated to be 132.4 m3/s units, and the suggested
data set is Ns = 147 m3/s units. Click Select Suggested Data Set and Close.
The Ns = 147 m3/s units data set will now be selected, and the
dimensionalized curve will be displayed against the previously entered
Standard Pump Curve (Figure 4.5).
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Note: It is always advised to select a Preferred data set close to the pump’s
specific speed when possible. An Average data set may be selected if there are
no close Preferred data sets, as was done here.

6. Make sure that the Four Quadrant Curve Dimensional Reference Point is
set to use the Best Efficiency Point. We will select the Steady-State
Operating Point option later for the third scenario. Click OK on this
window and the Pump Properties window.

7. Repeat the above steps for junction J8. The required input for this scenario
will then be complete.

Figure 4.6 The Pump Model tab defined using the Four Quadrant Curve,
where the Flow Directional Behavior section shows the pump
behavior for both forwards and reverse flow and speed
possibilities

B. Four Quadrant SSOP
Clone the “Four Quadrant BEP” scenario by right-clicking the scenario name in
the Scenario Manager and choosing Clone Without Children. Name this cloned
scenario “Four Quadrant SSOP”. For both pumps, open the Pump Properties
window and click the Specify Model button under Four Quadrant Curve. Change
the Four Quadrant Curve Dimensional Reference Point to Steady-State
Operating Point, then click OK on all open windows to accept the changes. The
required input for this scenario is now complete.

Step 7. Run the four quadrant scenarios

Using the Scenario Manager load each of the four quadrant scenarios and run
them. Once all of the scenarios have been run, go to the Graph Results tab.
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Multi-scenario graphing can be used to compare the results for all of these
scenarios. To create the multi-scenario graph, do the following.
1. Double-click the “Pressure & Flowrate vs. Time” graph in the Graph List

Manager on the Quick Access Panel. This will load the saved graph for the
current scenario.

2. Select the Multi-Scenario button in the Parameters section of the Quick
Access Panel. Check the box next to each of the child scenarios so that they
will be included in the multi-scenario graph.

3. Click OK to confirm your selections, then click Generate to update the
graph to include the additional scenarios.

As shown in Figure 4.7, the colored curves of the Standard Pump Curve
scenario and the two four quadrant scenarios show no major differences.

Comparison between the four quadrant graphs and standard pump curve graph
reveals that the results are similar, though there is a visible difference of about
0.1 barG between the maximum and minimum points in the four quadrant
scenario graphs and the standard pump curve scenario graph after the discharge
valves close fully at five seconds. These differences can be attributed to the
larger flow oscillations that occur when the pump head is fixed to the zero-flow
head for all values of reverse flow. Overall, the effects of reverse flow are minor
in the standard pump curve scenario.

On the Output window Warnings tab for each four quadrant scenario,
information will be given on the four quadrant options that are defined in the
pump, as well as listing topics which provide more background information on
four quadrant data.

Figure 4.7 Valve discharge pressure, pump suction pressure, and
volumetric flow rate for the Standard Pump Curve, Four
Quadrant BEP, and Four Quadrant SSOP scenarios
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Step 8. Adjust the valve closure speed

Now, consider the case where the valves at the discharge of the pumps cannot be
closed in five seconds, but instead will close fully at 12 seconds. In this case the
reverse flow at the pump will be significant due to the delay in the valve closure
profile. We will need to use a four quadrant data set to analyze the effects of the
possible reverse flow and reverse rotation in the pump, since the Standard Pump
Curve does not have sufficient data. We will use the default selection to use the
pump BEP as the dimensional reference point, though using the steady state
operating point as the reference point would produce similar results.

In the Scenario Manager, select the Four Quadrant BEP scenario and create a
child scenario named “12 Sec Valve Closure”. The new child scenario should
now be active. Pumps J6 and J8 will already inherit the four quadrant model
from the Four Quadrant BEP scenario, but we will need to adjust the valves. For
Valves J7 and J9 open the Valve Properties window, then edit the Transient
Data table found on the Transient tab to reflect the following closure profile.
This scenario should now be complete.

Time (seconds) Cv

0 10,000

5 1,000

12 0

30 0

Step 9. Specify the Transient Control group

Since the valve closure takes a longer time, it will be useful to extend the
simulation Stop Time to see more oscillations in pressure and flowrate when
graphing. Open the Simulation Mode/Duration panel from the Analysis Setup
and change the Stop Time to 30 seconds, then click OK.

Step 10. Run the model

The model should now be fully defined and ready to run. Select Run Model
from the Common Toolbar or the Analysis menu. View the results by clicking
Graph Results at the bottom of the Solution Progress window.

Step 11. Graph results

Load the “Pressure & Flowrate vs. Time” graph from the Graph List Manager,
as seen in Figure 4.8. Note that as expected, a significant amount of reverse flow
occurs at the pump from about 6 to 12 seconds, requiring data beyond the
standard data which is typically used for forward flow with forward rotation at
the pump. The transient results show that the maximum pressures at the valve
outlet and the pump suction have been reduced.
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Figure 4.8 Transient pump suction and discharge pressures and
volumetric flowrates with a 12 second valve closure

Load the “Speed vs. Time” graph from the Graph List Manager, as seen in
Figure 4.9. Note how at about 9 seconds the pump begins to experience reverse
rotation. This means that from 6 to 9 seconds, the pump will have forward
rotation with reverse flow, then from 9 to 12 seconds, the pump will experience
reverse flow with reverse rotation. Both of these situations can be accounted for
using the additional information provided by the Four Quadrant Curve.

Figure 4.9 Pump Speed decay when the valves are modified to close
fully at 12 seconds

Conclusion

For the valve closure of five seconds a minimal amount of reverse flow was
experienced at the pump. As a result, the standard pump curve was sufficient,
since use of four quadrant data to accurately model this reverse flow had only a
small impact on the results. Additionally, the choices of using the BEP or Steady
State Operating Point to dimensionalize the four quadrant data were shown to be
very similar in the transient since the pump was operating close to its BEP. This
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is not always the case, especially when the pump operates far from BEP. For an
example which shows larger sensitivity to the selection of four quadrant data set
and choice of dimensional reference point see the “Selecting a Pump Four
Quadrant Curve” example accessed from “Show Examples…” in the Help menu.

Changing the valve to close fully at 12 seconds resulted in significant reverse
flow at the pump which required four quadrant data to be used. It was then
found that increasing the valve closure time reduced pressures at the valve and
pump.
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C H A P T E R 5

Pipe Forces from Valve Closure Example

This example examines a gravity drain system which transfers water from one
tank to another through a filter and a valve in the connecting pipeline. It is
necessary to determine the transient forces that occur when the valve is partially
closed in order to analyze pipe stresses and loads on the pipe supports.

Topics covered
� Defining force sets

� Graphing transient forces

� Evaluating the effect of frictional losses on transient pipe forces

� Using Isometric Pipe Drawing Mode

Required knowledge

This example assumes that the user has some familiarity with Impulse such as
placing junctions, connecting pipes, and entering pipe and junction properties.
Refer to the example in Chapter 2 for more information on these topics.

Model file

A partially completed model file will be utilized as the starting point for this
example. A completed version of the model file can be referenced if desired.
Both the initial and final model files can be found in the Examples folder as part
of the Impulse installation:

C:\Users\[username]\Documents\Datacor\Impulse 11\Examples
� Metric - Pipe Forces from Valve Closure - Initial.imp

� Metric - Pipe Forces from Valve Closure - Final.imp

Step 1. Open the model file

For this example, we will be starting from a pre-built model file which has the
fluid, pipes, and junction properties completed to save time.
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► From either the Startup screen or the File menu, browse to the model file
name shown above. The workspace should appear as shown in Figure 5.1.

A. Isometric Pipe Drawing Mode
The previous example models were drawn using the default Pipe Drawing
Mode, 2D Freeform. However, Impulse has two additional available drawing
modes, 2D Orthogonal and Isometric. Due to the nature of this model the
Isometric mode was used to visually interpret the pipe layout and provide a
better understanding of the system when analyzing calculated forces.

For future reference when using this feature, the Isometric drawing mode can be
turned on in the Arrange menu under Pipe Drawing Mode. It is not
recommended to switch the Pipe Drawing Mode once a model has been created
and saved. The isometric grid can also be turned on or off from the Arrange
menu. When drawing segmented pipes such as P5, a red-dashed preview line
will show how the pipe will be drawn on the isometric grid. As you are drawing
a pipe, you can change the preview line by clicking any arrow key on your
keyboard or scrolling the scroll wheel on your mouse. You can hold the ALT
key while adjusting a pipe by the endpoint to add an additional segment. This
can be used with the arrow key or mouse scroll wheel to change between
different preview line options.

For junctions such as J5, it may be useful to rotate the icon to be aligned with
the isometric grid. This can be accomplished by right-clicking on the junction
and choosing either Auto-rotate Icon or Customize Icon.

Figure 5.1 Layout of the gravity drain system with isometric grid on
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Step 2. Specify the Transient Control group

Click the Simulation Mode/Duration panel in the Transient Control group and
enter a Stop Time of 10 seconds.

Step 3. Define the Forces group

Click the Force Definitions panel in the Forces group.

A. Force Types
The Difference force type is intended to model the specific case where all of the
following criteria is true:
1. The force is between a pair of 90 degree elbows

2. The force is an axial pipe force

3. All pipes, fittings, and components between the elbow pair are in-line

4. There are no flow splits or branching paths between the elbow pair

The force equations in the Solver are specific to this geometry. The pipes and
components between the elbow pair can be horizontal, vertical, or sloped, but
the axial component of the fluid weight is not accounted for in the forces.
However, elevation and hydrostatic pressure are accounted for in the pressure
and flow solution. Furthermore, Impulse is a hydraulic solver; therefore, only
hydraulic forces are calculated. These are forces which act on the pipe from the
fluid.

Note: Pipes are assumed to be rigid bodies and Impulse does not account for the
effect of pipe deflection on forces.

Figure 5.2 Schematic of the Difference force type

The Point force type would be used for calculating the force at a Dead End
junction. It is calculated using the difference in fluid pressure and ambient
pressure, multiplied by the pipe area.

The Difference Exit force type would be used between a single 90 degree elbow
and a location where the fluid is leaving the system, such as an exit valve, exit
orifice, or nozzle.

The force sets in this example will use the Difference force type to calculate the
axial forces between 90 degree elbow pairs.
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B. Defining Force Sets
Generally, it is best to represent each elbow with a unique junction on the
Workspace (either an Elbow or Branch). This example assumes that the static
pressure loss in the elbows is negligible, and therefore, they are modeled as
Branch junctions which are lossless, with exception of the last elbow in Pipe P5
which is visually depicted with a pipe segment.

Using explicit junctions on the Workspace will make the Force Definitions
simple and straightforward, and will create computing stations at the exact
locations where the forces are being calculated. However, this can increase the
runtime if the pipes between the elbows have a short length compared to the rest
of the pipes in the model. For this reason, Force Sets can also be defined using
an intermediate computation station inside a pipe.

The first elbow pair is represented by J2 and J4 which will demonstrate the
setup when using explicit junctions. The second elbow pair is represented by J4
and the segment in Pipe P5 which will demonstrate the setup when using an
intermediate station.

Reminder: Segments are simply a visual representation of a bend that can be
added to a pipe. They do not represent a pressure loss or elevation change.

► Create a force set by clicking New. Then enter the data as shown in Figure 5.3.
Repeat this process for the second force set.
� Force Set 1:

� Name = 150 m to 160 m

� Force Type = Difference

� Start Pipe = 2

� Length To Start Node = 0 meters

� End Pipe = 3

� Length To End Node = 5 meters

� Force Set 2:
� Name = 160 m to 300 m

� Force Type = Difference

� Start Pipe = 4

� Length To Start Node = 0 meters

� End Pipe = 5

� Length To End Node = 15 meters
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Figure 5.3 Completed Force Definitions panel

The first force set spans between the first and last computation stations that are
between the J2-J4 elbow pair. The start corresponds to the Pipe P2 inlet,
therefore, the Start Pipe is P2 and the Length to Start Node is 0 meters. The end
corresponds to the Pipe P3 outlet, therefore, the End Pipe is P3 and the Length
to End Node is 5 meters.

The second force set starts at J4 but ends in the middle of Pipe P5. The start
corresponds to the Pipe P4 inlet, therefore, the Start Pipe is P4 and the Length to
Start Node is 0 meters. The end corresponds to the middle of Pipe P5 (which is
30 meters in total length), therefore, the End Pipe is P5 and the Length to End
Node is 15 meters.

Sectioning has produced one section each in Pipes P2 and P3 for the 150 m to
160 m force set and then 25 sections and 6 sections in Pipes P4 and P5,
respectively, for the 160 m to 300 m force set. Section length is 5 meters for
each pipe.

In this example, the sectioning conveniently results in computing stations at the
locations where we want to calculate forces. Where computing stations do not
coincide with the desired force calculation locations, some loss in accuracy will
occur. By increasing the number of sections in the controlling pipe during
sectioning, a greater number of computing stations will exist, thus reducing the
distance to the desired force calculation locations, at the expense of longer run
time.

► Click OK to close Analysis Setup.

Step 4. Run the model

All groups in Analysis Setup should now be complete and the model is ready to
run. Run the model by either pressing the Run Model icon on the Common
Toolbar, selecting Run Model in the Analysis menu, or pressing the CTRL+R
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keyboard shortcut. This will open the Solution Progress window. When
complete, press the Output button.

Step 5. Graph the pipe forces
► Go to the Graph Results window and select the Forces tab from the Graph

Parameters section on the Quick Access Panel. The force sets defined on the
Force Definitions panel will appear as available forces to graph.

► Check the boxes next to both Force Sets.

► Click Generate, and the following force vs time graph is displayed (Figure 5.4).

Figure 5.4 Force vs. Time for both force sets

Note that at time zero, which represents the initial, steady-state results, there is
no force. This is the expected result for a system at steady-state. Some
traditional methods of analyzing force sets will not have this same result, since
they do not include the effects of friction or momentum in their force balances.
If the graph from Figure 5.4 was created with friction and momentum ignored,
then the steady-state values would be calculated as approximately -5,100 N and -
11,940 N. Due to this effect, Impulse will always include both friction and
momentum when graphing force sets.
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Note: An Impulse model does not contain directional data with regard to the
forces, it knows only pipe length and elevation. Since forces are vectors with
both magnitude and direction, the user must identify the direction of the
calculated forces using data in the pipe arrangement drawing that defines the
geometry of the pipe routing.

Conclusion

In summary, there are several important points to be observed:
1. Impulse calculates transient, or time-varying hydraulic forces. This does not

include constant loads from fluid, piping, and component weight. A
comprehensive analysis of pipe loading must separately include these
items.

2. The Difference force type calculates the axial pipe force between a pair of
90 degree elbows.

3. In some cases, ignoring friction and momentum force balance components
will result in forces that do not exist in reality, since the frictional forces on
the pipe exactly counterbalance the force calculated from the pressure
differential at the selected locations.

Data that is obtained from the force sets in Impulse can be exported to CAESAR
II, ROHR2, TRIFLEX or other pipe stress analysis software for further analysis
on the impact of forces on the structural supports.
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C H A P T E R 6

Impulse Add-on Modules Examples

This chapter covers the Settling Slurry (SSL) and Pulsation Frequency Analysis
(PFA) modules. The user can only perform these examples if access to the
relevant modules is available.

Topics covered
� SSL - Defining settling slurry properties

� SSL - Reviewing slurry output

� PFA - “Ringing” systems to find natural acoustic frequencies

� PFA - Finding system excitation frequencies

� PFA - Calculating the pressure response of a system at ‘worst case’ positive
displacement pump speeds

Required knowledge

This example assumes that the user has some familiarity with Impulse such as
placing junctions, connecting pipes, and entering pipe and junction properties.
Refer to the example in Chapter 2 for more information on these topics.

Model files

The following examples have completed versions of the model files that can be
referenced from the Examples folder as part of the Impulse installation:

C:\Users\username\Documents\Datacor\Impulse 11\Examples
� Metric - Pipe Sizing for Sand Transfer - SSL.imp

� Metric - Positive Displacement Pulsation Study - PFA.imp

SSL problem statement

Sand is being transferred from a quarry sand pit to receiving deposits in two
different locations. There are two valves that control the flow to each of these
deposits by changing their opening position (modeled as Cv). The ratio of the
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mixture velocity to the velocity at which the sand will settle out of the liquid and
form a stationary bed on the bottom of the pipe (Vm/Vsm) must be kept above
1.2 to avoid potentially plugging the pipe. Determine if the pipe size and
velocity ratio is acceptable during the transient where one valve starts to close
while the other opens further.

SSL Step 1. Activate the SSL module

Open the Analysis Setup window and go the Modules panel under the Modules
group. Then, select the option to Activate SSL.

SSL Step 2. Define the Fluid Properties group

With the SSL module enabled, the four items in the Fluid Properties group in
Analysis Setup change to the three items required for defining a slurry: the
Carrier Fluid panel, the Solids Definition panel, and the Slurry Definition panel.

A. Carrier Fluid panel
1. Go to the Carrier Fluid panel (Figure 6.1)

2. Carrier Fluid = Basic (Water)

3. Temperature = 21 deg. C

Figure 6.1 Carrier Fluid panel

84 Impulse 11 Quick Start Guide



B. Slurry Definition panel
1. Go to the Slurry Definition panel (Figure 6.2)

2. Slurry Model = Settling Slurry - Wilson, Addie, Clift

3. Slurry Calculation Method = Detailed

4. Concentration Type = Volume Fraction

5. Amount Solids Added = 20 Percent

Figure 6.2 Completed Slurry Definition panel

C. Solids Definition panel
1. Go to the Solids Definition panel (Figure 6.3)

2. Solids Specifications = User Specified Solids Added

3. M (Stratification Ratio Exponent) = Calculated

4. Terminal Velocity Parameter, Vt/Vts (Xi) = 0.55

5. Density = 2.65 S.G. water

6. d50 = 0.07 cm

7. d85 = 0.17 cm

8. Bulk Modulus = 16000 MPa

9. Click OK to save and close Analysis Setup
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Figure 6.3 Completed Solids Definition panel

SSL Step 3. Define the Pipes and Junctions group

A. Place the pipes and junctions
In the Workspace window, assemble the model as shown in Figure 6.4.

Figure 6.4 Layout of the pipe system for the Sand Transfer to Two
Locations example
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B. Enter the pipe and junction data
The system is in place, but now the input data for the pipes and junctions needs
to be entered. Double-click each pipe and junction and enter the following data
in each Pipe and Junction Properties window.

Pipes
All pipes will use the following properties:
1. Pipe Material = Steel - ANSI

2. Size = 10 inch

3. Type = STD (schedule 40)

4. Friction Model = Standard

5. Wavespeed, Pipe Support = Thick-Walled Anchored Upstream

6. Length = see the table below

Pipe Length (meters)

1 3

2 122

3 1.5

4 26

5 122

6 1.5

7 30.5

8 213

J1 - Reservoir
1. Name = Sand Pit

2. Liquid Surface Elevation = 0 meters

3. Liquid Surface Pressure = 0 barG

4. Pipe Depth = 0 meters

J2 - Pump
1. Name = Main Slurry Pump

2. Inlet Elevation = 1.2 meters

3. Pump Model = Centrifugal (Rotodynamic)

4. Enter Curve Data = see the table below
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Volumetric Head Power

m3/hr meters kW

0 152 764

910 145 820

1595 122 894

2050 91 1006

5. Curve Fit Order = 2

6. Click Generate Curve Fit Now, then click OK

J3 - Branch
Elevation = 1.2 meters

J4 - Valve
1. Name = Valve to Deposit #1

2. Inlet Elevation = 1.2 meters

3. Loss Source = User Specified

4. Loss Model = Cv

5. Cv = 500

6. Click the Transient tab

7. Transient Data =

Time (seconds) Cv

0 500

1 500

6 300

10 300

J5 - Branch
Elevation = 6 meters

J6 - Reservoir
1. Name = Deposit #1

2. Liquid Surface Elevation = 6 meters

3. Liquid Surface Pressure = 0 barG

4. Pipe Depth = 0 meters
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J7 - Valve
1. Name = Valve to Deposit #2

2. Inlet Elevation = 1.2 meters

3. Loss Source = User Specified

4. Loss Model = Cv

5. Cv = 400

6. Click the Transient tab

7. Transient Data =

Time (seconds) Cv

0 400

5 500

10 500

J8 - Branch
Elevation = 9 meters

J9 - Reservoir
1. Name = Deposit #2

2. Liquid Surface Elevation = 9 meters

3. Liquid Surface Pressure = 0 barG

4. Pipe Depth = 0 meters

C. Create a Design Alert
In this system the Velocity Ratio (mixture to settling velocity ratio or Vm/Vsm)
must remain greater than 1.2 in each of the pipes to avoid the potential of the
sand falling out of the slurry and plugging the pipe. Use the Design Alert
Manager to add a Design Alert to each pipe. This will give a warning message
in the output if the velocity ratio is below the minimum value.

► From the Tools menu, select Design Alerts to open the Design Alert
Manager. Click the green plus icon to create a new Design Alert.
1. Name = Min Velocity Ratio (Vm/Vsm)

2. Alert Applies To = Pipes

3. Parameter Type = Velocity Ratio (Vm/Vsm)

4. Alert When Values Is = Less Than or Equal To (<=)

5. Value = 1.2

6. Click the All button under the Pipes in Design Alert list
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7. The Design Alert Manager window should now appear as shown in Figure
6.5

8. Click OK to return to the Workspace

Figure 6.5 Creating a minimum velocity ratio Design Alert

Open the Pipe Properties window of any pipe and click the Design Alerts tab.
Check to confirm that the Design Alert you created has been applied (Figure
6.6).

Figure 6.6 Design Alerts tab of the Pipe Properties window
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D. Check if the pipe and junction data is complete
Turn on “Show Object Status” from the toolbar or View menu to verify if all
data is entered. If so, the Pipes and Junctions group in Analysis Setup will have
a check mark. If not, the pipe or junction number of any uncompleted pipes or
junctions will be shown in red. If this happens, go back to the uncompleted
pipes or junctions and enter the missing data.

SSL Step 4. Specify the Pipe Sectioning and Output group

Open Analysis Setup and go to the Sectioning panel. When this panel is first
opened, it will automatically search for the best (least number of sections within
10% variance) option for one to five sections in the controlling pipe. The results
will be displayed in the table at the top. No input is required for this step.

SSL Step 5. Specify the Transient Control group

Go to the Simulation Mode/Duration panel in the Transient Control group and
enter a Stop Time of 10 seconds.

SSL Step 6. Run the model

All groups in Analysis Setup should now be complete and the model is ready to
run. Run the model by pressing the “Run Model” icon on the Common Toolbar,
selecting “Run Model” in the Analysis menu, or pressing CTRL+R on the
keyboard. This will open the Solution Progress window. When complete, press
the “Output” button.

SSL Step 7. Review results

Clicking “Output” on the Solution Progress window will take you to the Output
window.

A. Check the Transient Max/Min
As a design objective, the system is required to have at minimum a Vm/Vsm of
1.2 to avoid the potential of the sand falling out of the slurry and plugging the
pipe.

By inspecting the Min. Vm/Vsm column in the Transient Max/Min tab, as
shown in Figure 6.7, it can be seen that the minimum Vm/Vsm drops below this
value in Pipe P4 (scroll to the left to find the column). The Design Alert is
violated which results in the cell being highlighted.
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Figure 6.7 Design Alert violation in Pipe P4

There are several factors that may be contributing to this low Vm/Vsm value.
Pipe P4 is sloped upward which increases the settling velocity and decreases the
velocity ratio of concern. Also, all pipes in the model have a 10 inch diameter.
However, the main pipes P1 and P2 are carrying much more flow than the others
so the pressure drop in these is greater. This could be reduced by increasing the
size. The size cannot be increased too much because this would reduce the
velocity ratio below the 1.2 minimum.

B. Increase the Pipe Diameter and Re-run the Model
Return to the Workspace and change Pipes P1 and P2 to have a 14 inch
diameter. Since the size of the pipes was changed, the pipes need to be re-
sectioned by opening the Sectioning panel in the Analysis Setup window. Click
OK to accept the results.

Re-run the model and view the Output. All pipes should meet the requirements
now that the pipes were changed. The Graph Results window will be more
useful in understanding the results.

C. Graph the velocity ratio and pressures to Deposit #1
Stacked graphs will be used to simultaneously view the maximum and minimum
velocity ratio and pressures in the system during the transient.
1. Change to the Graph Results window by either clicking on the Graph

Results tab, from the Window menu, or by pressing CTRL+G.
2. Click the Profile tab in the Parameters definition area.

3. Select Pipes P1 through P5 (Figure 6.8). These represent the flow path to
Deposit #1.

4. Add a second Parameter by clicking the green “+” icon. Choose “Velocity
Ratio (Vm/Vsm)” for one parameter and “Pressure Static” in units of barG
for the other.

5. Check the boxes for Mx, Mn, and DA in order to display the maximum,
minimum, and Design Alert.

6. Click Generate. The resulting graphs are shown in Figure 6.9.
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Figure 6.8 Data selection to view the maximum and minimum values of
the velocity ratio and static pressure along the flow path to
Deposit #1

Recall that, before modifying Pipes P1 and P2 to 14 inch pipe, the minimum
velocity ratio was below the design alert limit of 1.2 for a portion of the path.
Now with 14 inch pipe, the minimum is above the 1.2 limit along the entire
path. You can also check the same parameters for the flow path leading to
Deposit #2.
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Figure 6.9 Maximum and minimum velocity ratio and static pressure
values in the flow path to Deposit #1, where the velocity ratio
is above the minimum Design Alert of 1.2 at all locations

D. Graph the velocity ratio over time
A time comparison of the velocity ratio in the critical pipes along the two flow
paths is important to consider.
1. On the Transient Pipe tab, select Pipes P4 Inlet and P7 Inlet and add them

to the Graph These Pipes/Stations list (Figure 6.10). These are the two
sloped pipes which have the lowest velocity ratio.

2. Choose Velocity Ratio (Vm/Vsm) as the Parameter to graph.

3. Check the DA box to display Design Alerts on the graph.

4. Click Generate.

The resulting graph is shown in Figure 6.11. This shows that, as Valve J4 closes
and Valve J7 opens, the velocity ratios in the pipe immediately downstream
change but stay in the acceptable range.
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Figure 6.10 Data selection to view the velocity ratio over time

Figure 6.11 The velocity ratio in the sloped pipes as the valves change
position
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SSL Conclusion

A slurry of sand and water flowing to two deposits was modeled. The velocity
ratio (Vm/Vsm) was examined to ensure a minimum value was maintained
throughout the transient to avoid the danger of the sand settling out of the slurry
and plugging the pipe. The analysis showed that the initial pipe diameter
selected was not adequate and the created Design Alert was violated. A larger
size was selected to meet the system requirements over the simulation time.

PFA problem statement

A system with positive displacement pumps has a known pulsation issue in a
section of piping with a closed valve. This issue is caused by the system’s
natural frequency resonating with certain PD pump frequencies, resulting in
severe pressure oscillations at the closed valve. A forcing function will be placed
on the PD Pump to discover the natural acoustic frequencies, which will then be
used to find the worst-case scenarios for the system.

PFA Step 1. Activate the PFA module

Open the Analysis Setup window and go the Modules panel under the Modules
group. Then, select the option to Activate PFA.

PFA Step 2. Define the Fluid Properties group
1. Open Analysis Setup using the button on the Common Toolbar or from the

Analysis menu.
2. Open the Fluid panel and make sure User Specified Fluid is selected

3. Name = PFA Fluid

4. Density = 0.92 gram/cm3

5. Dynamic Viscosity = 0.95 centipoise

6. Bulk Modulus = 9653 bar

PFA Step 3. Define the Pipes and Junctions group

At this point, the first two groups are completed in Analysis Setup. The next
group is the Pipes and Junctions group.

A. Place the pipes and junctions
In the Workspace window, assemble the model as shown in Figure 6.12.
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Figure 6.12 Layout of the PD Plunger Pulsation Study example

B. Enter the pipe and junction data
The system is in place, but now the input data for the pipes and junctions needs
to be entered. Double-click each pipe and junction and enter the following data
in each Pipe and Junction Properties window.

Pipes
All pipes use a user-specified material (scroll to the top of the Pipe Material list)
with the following inputs. Throughout the model a User Specified Wavespeed of
915 m/s is used, and the absolute roughness is 0.00152 cm.

Pipe
Inner

Diameter
(cm)

Length
(meters)

1 30.5 1

2 30.5 1

3 5.5 12

4 5.5 17

5 8.3 10

6 4.3 6

7 8.3 15

8 4.3 1

9 8.3 9
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J1 & J2 - Assigned Flows
For the sake of simplicity, assigned flow junctions are being used to represent
the PD pumps with the information listed below. The Pulsation Setup group in
Analysis Setup will be used later to place the necessary transient data in the
assigned flow junction for the pump being analyzed.
1. Elevation = 0 meters

2. Flow Specification = Volumetric Flow Rate

3. Flow Rate = 8 m3/hr

J3 & J4 - Area Changes
1. Inlet Elevation = 0 meters

2. Type = Abrupt Transition (Cylindrical)

J8 & J9 - Area Changes
1. Inlet Elevation = 0 meters

2. Type = Conical Transition

3. Angle (μ) = 90 Degrees

J5 & J6 - Tees
1. Elevation = 0 meters

2. Loss Model = Simple

J10 - Spray Nozzle
1. Elevation = 0 meters

2. Loss Model = Cd Spray (Discharge Coefficient)

3. Geometry = Spray Nozzle

4. Exit Properties = Pressure

5. Exit Pressure = 0 barG

6. Cd (Discharge Coefficient) = 1

7. Discharge Flow Area = 0.148 cm2

J7 - Dead End
Elevation = 0 meters

C. Check if the pipe and junction data is complete
Turn on “Show Object Status” from the toolbar or View menu to verify if all
data is entered. If so, the Pipes and Junctions group in Analysis Setup will have
a check mark. If not, the pipe or junction number of any uncompleted pipes or
junctions will be shown in red. If this happens, go back to the uncompleted
pipes or junctions and enter the missing data.
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PFA Step 4. Define Pulsation Setup group

Defining the initial pulse or “ring” is an important step in determining the
natural frequencies that different stations in the model will respond to. This is
the numerical equivalent of hitting the system with a hammer to see how it
responds at different frequencies. This first step does not represent a realistic
operating condition, but rather reveals what frequencies of real-world operation
may present operational problems.

Open Analysis Setup and go to the Pulsation Frequency Analysis panel in the
Pulsation Setup group. The Pulsation Frequency Analysis panel is the main
interface for specifying input regarding the initial pulse and other information
about the pulsation source. There are two types of analysis modes available in
the Pulsation Frequency Analysis panel. The Natural Frequency Evaluation will
produce a single transient pulse at a specified assigned flow or fixed flow rate
positive displacement pump junction so as to determine the frequencies that
would excite the system. The Steady State Pulsation option will determine how a
pulsation source, such as a reciprocating pump, would interface with a system in
steady operation. The Natural Frequency Evaluation mode can be used to
generate Steady State Pulsation analyses at problematic pump speeds based on
the system's resonant frequency.

A. Define Pulse Location and Frequency Domain
Define the Pulsation Frequency Analysis panel (Figure 6.13) using the following
values:
1. Frequency Analysis Mode = Natural Frequency Evaluation

2. Applied At = J2

3. Minimum Number of Frequency Samples = 1000

4. Cutoff Frequency = Estimated

5. Number of Heads = 3

6. Pump Speed = 250 RPM

7. Speed Buffer = 15 Percent (%)

8. Value = 86.25 Hz (populates after completing the steps above)
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Figure 6.13 Completed Pulse Location and Frequency Domain sections of
Pulsation Frequency Analysis

B. Define Excitation RPM Scenarios
Define the Excitation RPM Scenarios section (Figure 6.14) using the following
values:
1. Excitation RPM Scenarios checked

2. Minimum Pump Speed = 125 RPM

3. Bore = 7.6 cm

4. Stroke = 5.2 cm

5. Rod Length = 25.4 cm

6. Number of Heads = 3

7. Clearance = 70 Percent (%)

8. Suction Pressure = 4.5 barG

9. Discharge Pressure = 415 barG
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Figure 6.14 Excitation RPM Scenarios are used to generate read only
Steady State Pulsation child scenarios

PFA Step 5. Define the Transient Control Group

According to the Pulsation Summary in the Pulsation Frequency Analysis panel,
the Minimum Required Simulation Duration is 2.19 seconds. Several factors go
into simulation duration selection for pulsation analysis. To have a sufficient
number of samples for frequency analysis, the simulation duration should be at
least an order of magnitude greater than the Minimum Required Simulation
Duration and one to two orders of magnitude greater than the total
communication time for the system. For this system, the total wave
communication time from J2 to J10 and back is 0.116 seconds, which implies
that the simulation duration should be at least 12 seconds. However, this is less
than the length of time needed to ensure that the simulation duration is an order
of magnitude greater than the Minimum Required Simulation Duration, so a
duration of 30 seconds will be used to comfortably satisfy both of these
recommendations.

Go to the Simulation Mode/Duration panel in the Transient Control group of
Analysis Setup. In the Stop Time field, enter 30 with units of seconds (Figure
6.15). Hit OK. A message will appear confirming that the PFA Module has
applied a forcing function to J2. Pipe sectioning has been automatically applied
and the model is ready to run.
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Figure 6.15 Simulation Mode/Duration panel

Open J2 to verify that the numerical “ring” has been applied to the transient (see
Figure 6.16 for the transient input). This transient is a brief jump in flow rate at
junction J2, which can be displayed with Show Graph.
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Figure 6.16 Assigned Flow Properties with the forcing function applied to
J2

PFA Step 6. Run the model

All groups in Analysis Setup should now be complete and the model is ready to
run. Run the model by pressing the “Run Model” icon on the Common Toolbar,
selecting “Run Model” in the Analysis menu, or pressing CTRL+R on the
keyboard. The Waterhammer Assistant window may open when the model is
run. This window is a tool which provides advice to help simplify and improve
the model before it is run. In this case we are intentionally using the Assigned
Flow junctions to represent the PD Pumps and the forcing function, so click OK
to dismiss the Waterhammer Assistant. This will open the Solution Progress
window. When complete, press the “Graph Results” button.
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PFA Step 7. Review results

A. View the Frequency Response Function
1. On the Graph Control tab on the Quick Access Panel, click the Frequency

tab to begin generating an Acoustical Frequency Analysis graph.
2. We need to determine which pump speeds within our specified range excite

the resonant frequencies of the system. For the purposes of this example,
we will graph the Frequency Response Function for 10 different pipe
stations. Note that it is the engineer’s responsibility to evaluate all pipe
stations that could be excited by various frequencies and to perform the
necessary analysis.

3. On the Graph Results tab, select the Frequency tab and select the inlet and
outlet stations for the following pipes: 1, 2, 3, 5, and 6.

4. Click Generate. The resulting graph (shown in Figure 6.17) represents the
frequencies that are excited by the pulse defined in the Pulsation Setup
group.

From the graph in Figure 6.17, we see that there are several frequencies that
produce a large pressure magnitude. Points on the plot with a large response
magnitude are easily identified by finding local maxima on the graph. These
maxima are the acoustic natural frequencies that are potentially the most
damaging when excited by the identified pump speeds.

Note that the graph in Figure 6.17 can quickly be changed to display the
magnitude on a logarithmic scale in order to allow for easier viewing of the
magnitude behavior changes with a changing frequency. To view the Acoustical
Frequency Analysis graph with the magnitude displayed on a logarithmic scale,
generate the frequency graph as discussed above. Right-click on the y-axis and
select the box next to Logarithmic.
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Figure 6.17 Acoustical Frequency Analysis graph

B. Choose excitation frequencies to evaluate
The identified frequencies can now be evaluated to determine pump speeds that
would cause them to be excited. These natural frequencies need to be evaluated
to examine potentially problematic pump speeds. Follow the steps below to
select the excitation frequencies:
1. With the crosshair cursor off, left-click near the frequency of around 33.2

Hz and drag the mouse over the peak on the graph near this frequency. This
will highlight and flag the local maximum.

2. Right-click on the dialog flag that appears on the peak of this frequency, as
demonstrated in Figure 6.18.

3. Select “Evaluate Excitation Frequency” to add this frequency to the
Excitation Frequencies and Pump Speeds (RPM) panel, which is labeled
with “Excitation Frequencies and Pump Speeds (RPM)”. Repeat steps 1
through 3 for the local maxima around the frequencies of 29.0 Hz and 6.9
Hz. The panel should now appear as shown in Figure 6.19.
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Figure 6.18 Acoustical Frequency Analysis with the local maxima
selected, where right-clicking on the Dialog Flag provides the
option to Evaluate Excitation Frequency

Figure 6.19 Excitation Frequencies and Pump Speeds (RPM) panel with
Excitation Frequencies and their Harmonic Multiples
Displayed in the bottom of the Quick Access Panel

When choosing low or high frequencies on the graph, it is possible to select a
frequency which is excited in the system but does not have a pump speed within
the minimum and maximum pump speeds for the analysis. The minimum pump
speed is defined directly in the PD Pump Settings panel, while the maximum is
calculated using the Pump Speed and Speed Buffer defined under “Pulsation
Source” in the Pulsation Frequency Analysis panel. For example, try selecting
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the largest maxima, which occurs at about 6.0 Hz. The message in Figure 6.20
appears.

Figure 6.20 Message indicating no excitation pump speeds between the
min and max pump speeds exist

C. Create excitation RPM child scenarios and determine the
pressure response of the system at excited frequencies
In the Excitation Frequencies and Pump Speeds (RPM) panel, corresponding
pump speeds can be selected for study. At these speeds, the pressure response is
important to characterize. By default, all speeds in the Excitation Frequencies
and Pump Speeds (RPM) panel are pre-selected. Clicking a speed harmonic
multiple will toggle it on or off. Speeds that are toggled off will appear with the
number in italic font. Child Pump Speed scenarios can then be created that will
have the Flow vs. Time profile at the selected speed (RPM) that will excite the
evaluated frequencies.

We will create child scenarios for all selected pump speeds in the Excitation
Frequencies and Pump Speeds (RPM) panel. To do this, ensure that pump
speeds are selected (not italicized).
1. Click “Create Scenarios Based On Selected Pump Speeds…”.

2. A dialog box will appear stating that six scenarios will be created based on
the selected speeds in the Excitation Frequencies and Pump Speeds (RPM)
panel. Click Yes to continue creating the child scenarios.

3. Double-click on the “132.9 RPM (33.2 Hz)” child scenario to load it as the
current scenario.

The scenario will now have different transient information in J2, modeling the
pump performance at 133 RPM. Go to the Workspace and open the Properties
window for J2. On the Transient tab click Show Graph under the Transient Data
table to verify the Pump Flow Forcing Function has been applied, as shown in
Figure 6.21.
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Figure 6.21 New Assigned Flow transient representing the PD Pump
operating at the specified RPM

Run the “132.9 RPM (33.2 Hz)” scenario to see the pressure response. Often,
the most noticeable pressure response will occur in stagnant, branched lines. For
the purposes of this example, we will evaluate the pressure responses through
Pipe P6. However, engineers must ensure that all pipes that could experience
significant pressure responses are analyzed.
1. To create a pressure profile graph in Pipe P6, go to the Graph Results tab

and select the Profile tab
2. Check the box for Pipe P6

3. Use Pressure Static for the Parameter

4. Use bar for the units

5. Click Generate

6. Right-click on the y-axis and adjust the scale by unchecking the Auto Scale
box, then changing the Minimum to 240 and the Major Val to 20.

Figure 6.22 shows the profile plot for Pipe P6 at a pump speed of 132.9 RPM.
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Figure 6.22 Max/Min Pressure Profile of Pipe P6 for 132.9 RPM

The pressure vs. time can be displayed for any pipe station. Plot the pressure vs.
time for Pipe P6 by following the directions below:
1. In the Quick Access Panel, select Transient Pipe for the graph type.

2. Add the outlet and inlet of Pipe P6 to the Graph These Pipes/Stations list.

3. Use Pressure Static for the Parameter.

4. Use bar for the units.

5. Set the Time Frame to User Specified with a Start Time of 0 and a Stop
Time of 2 seconds.

6. Click Generate.

7. Right-click on the y-axis and uncheck the Auto Scale option. Set the
Minimum to 270, the Maximum to 300, and the Major Val to 5. The
resulting graph is shown in Figure 6.23.
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Figure 6.23 Pressure Oscillations at the Inlet and Outlet of Pipe P6 for
132.9 RPM

After looking at these graphs, return to the Output tab and make note of the
message in red at the bottom-right of the screen that states that Warnings Exist.
These warnings are reported in the upper third of the Output window and warn
the user of potential issues with the model.

The PFA module will check the Peak-to-Peak pressures and compare them to
the permissible values in the API 674 standard. If the limits from the standard
are violated in the model, a warning will appear like in this case, where the
Peak-to-Peak pressures exceeded the allowable limits. Additionally, the vapor
pressure margin is checked. This is the margin between the minimum pressure
and 10% over the vapor pressure, per the API 674 standard. More information
on this can be seen on the Applied Standards and Pulsation Summary tabs.

For the purposes of this example, we will repeat these steps for the pump speed
of 221.6 RPM because this pump speed causes the largest pressure oscillations.
When performing an analysis on your system, all pump speeds that excite the
system should be evaluated.

Figure 6.24 shows the Max/Min Pressure Profile for Pipe P6 for the pump speed
of 221.6 RPM. The y-axis has been adjusted to scale from 400 to 500, with a
Major Val of 10.
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Figure 6.24 Max/Min Pressure Profile of Pipe P6 for 221.6 RPM

Notice the large difference between the maximum and minimum pressures at the
end of the pipe, located next to the Dead End junction.

The large pressure oscillation in Pipe P6 can be seen in Figure 6.25 (the y-axis
has been adjusted to scale from 430 to 480, with a Major Val of 10). It is
important to note that the inlet of Pipe P6 does not exhibit as large of a response
as the outlet does. This oscillation, if allowed to continue, can lead to
mechanical and support fatigue resulting in failure. It should be noted in the
Output that this scenario also violates the API 674 standard.

111 Impulse 11 Quick Start Guide



Figure 6.25 Pressure Oscillations at the Inlet and Outlet of Pipe P6 for
221.6 RPM

PFA Conclusion

Impulse and the PFA (Pulsation Frequency Analysis) module were used to
discover the problematic pump frequencies occurring in a system with a known
pulsation issue. The software was used to identify these frequencies, and after
the frequencies were identified, a corresponding pump operating speed was
examined to find the pressure response of the system. Using graphing features,
the pressure response was plotted and studied. It was determined that the
pressure response violated the API 674 standard, and a warning was given in the
software.
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C H A P T E R 7

Other Impulse Capabilities

This Quick Start Guide necessarily omitted or had brief coverage of a number of
important Impulse capabilities. This chapter briefly describes some of the
important capabilities not covered.

You can find a number of other example model discussions on the Datacor Pipe
Flow Modeling documentation help website. To view additional examples, open
the Help menu and choose Show Examples or go to docs.aft.com, select the
Impulse Help Site, expand the Examples section in the sidebar, then select
Walk-Through Examples.

Microsoft Excel™ data integration

Impulse includes Excel importing and exporting. An Excel spreadsheet can be
used to vary selected input parameters in multiple scenarios. Selected output can
also be exported to specified Excel sheets and cells.

Integration with other software and data standards

Impulse includes a number of importing and exporting capabilities. Piping
layouts and dimensional data can be imported from GIS Shapefiles (*.SHP) to
build a model. CAESAR II Neutral Files (*.CII) can be imported into Impulse
and EPANET Files (*.INP) can be both imported and exported. Additionally,
force files can be exported for use in CAESAR II, TRIFLEX, and ROHR2.

Piping Component Files (*.PCF) from AutoCAD Plant 3D, SmartPlant, PDS,
CADWorx, and other software can be imported into Impulse. These options are
all accessed from the File Menu. PCF importing supports multiple files at once
and uses zero-length connectors to handle welded junctions automatically. Pipe
length units can be adjusted during import, and a dedicated window allows pipe
materials to be defined before importing.

Variable density and viscosity modeling

Systems that have variable density and viscosity can be modeled. The density
and viscosity can be assigned on a pipe by pipe base.
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Transient cavitation and liquid column separation

Impulse offers the Discrete Gas Cavity model (DGCM) and the Discrete Vapor
Cavity model (DVCM) for modeling transient cavitation (also known as liquid
column separation). These models calculate vapor volume size over time and
account for pressure spikes when cavities collapse. Vapor volume can be plotted
in the Graph Results window.

Positive displacement pumps

Impulse can model positive displacement pumps. Typically, this is done by
modeling the pump as a known flowrate over time. Complicated periodic
flowrates from multiple pistons and/or multiple out of phase pumps can also be
modeled.

Reciprocating pumps

Impulse's Reciprocating Pump modeling supports both single-acting and double-
acting configurations, along with customizable cylinder arrangements. Multiple
cylinders can be defined to simulate a wide range of positive displacement pump
setups. This allows accurate representation of real-world pump behavior in the
model.

Pumps with viscosity corrections

When the liquid is sufficiently viscous, centrifugal pump performance will be
degraded. Impulse models corrections to manufacturer performance curves
during steady and transient flow.

Pumps with variable speed controllers

Pumps with speed controllers can be modeled during steady and transient flow.
Transients caused by flow or pressure control level changes with time can be
modeled.

Pumps as turbines (PAT)

Pumps being operated as turbines can be modeled during steady and transient
flow using the Pump as Turbine model in the Pump junction.

Flow and pressure control valve transients

Impulse can model flow and pressure control valves. Impulse accounts for
control valves which lose and regain control during the transient. Transients
caused by changes in flow or pressure control setpoints can also be modeled.
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Air valves

Air valves (also known as vacuum breaker valves) are used to protect against
low pressure conditions. Impulse can model air valves, including different
inflow and outflow geometries. Gas volume is assumed to remain fixed at a
single computation point and does not travel down the pipeline.

Surge tanks

Surge tanks are a surge suppression device used in low pressure systems with
non-volatile fluids. Impulse can model surge tanks, including transient surface
pressure for enclosed tanks.

Relief valves

The Relief Valve junction allows user-defined combinations of opening and
closing profiles based on parameters such as time or pressure. Users can define a
blowdown pressure for relief valves that close at pressures below the set
pressure. Relief valves can have constant backpressure acting on the valve stem
(hydraulically balanced) so the set points can be defined as absolute upstream
pressures, or the set points can be entered as a pressure difference across the
valve. For valves with pressure profiles, the Cv profile for the valve can be user-
defined or set based on the valve set points. Users can also add opening and
closing rate limits.

Infinite pipe boundaries

Infinite pipe boundaries can be very useful for long, non-reflecting pipes. Model
run times can be significantly reduced with these elements. Both Assigned Flow
and Assigned Pressure junctions can be specified to behave as infinite pipe
boundaries during transients.

Non-Newtonian fluid modeling

Impulse can model steady and transient flow of Non-Newtonian fluids which
behave as Power Law, Bingham Plastic, Herschel-Bulkley, or Homogeneous
Scale-up viscosity models.

Pulp and paper modeling

Impulse can model steady and transient flow of pulp and paper stock using the
Duffy method or Brecht & Heller method.

Repeat transient feature for periodic transient behavior

For elements which have periodic behavior (such as positive displacement
pumps), one cycle of data can be entered and then specified to repeat once the
cycle is finished.

115 Impulse 11 Quick Start Guide



Intermediate elevations for pipes

Typically, elevation changes along pipes do not affect the steady or transient
system. Exceptions are high points which cavitate. If desired, Impulse can model
varying elevations along a single pipe.

Fitting library

Impulse offers a library of about 400 fitting losses which can be added to pipes.

Design alerts

Design Alerts can be created for pipes and junctions to alert the user that one of
their project constraints has been violated. A common use is maximum and
minimum allowed operating pressure. If the resulting value for that parameter
violates the Design Alert a warning message is given in the Output. Design Alert
values can also be cross plotted in the Graph Results.

Design Alert Layer

The Design Alert Layer displays color-coded indicators directly on the
Workspace to show where Design Alerts have been triggered. Each highlighted
object is labeled with the violated condition and its evaluated value. This allows
quick identification of areas that exceed system requirements across multiple
conditions.

Libraries

Junction components and pipe materials can be saved to libraries for later reuse.
Libraries can be located on local PCs or deployed across local or wide area
networks. The Library Manager allows users to connect to relevant libraries for
their specific pipe system design.

Workspace Layer animations

The Workspace Layers provides the ability to animate the transient results as a
qualitative tool to visualize the behavior in a network. One parameter can be
animated using absolute values, values relative to the steady-state, or a static
map of all maximum/minimum transient values can be generated. The animation
can also be recorded to a file.

Compare input from different scenarios

The Scenario Comparison Tool can be used to compare pipe, junction, and
general model file inputs for any number of scenarios in the model file. This
allows the user to quickly identify differences between scenarios, or to generate
a report on inputs for different cases.
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Scenario Comparison Layer

The Scenario Comparison Layer highlights differences between the current
scenario and a selected comparison scenario directly on the Workspace. Color-
coded objects indicate changes, and each one displays specific parameter and
value differences through labels and the Inspection Window. This provides a
visual way to analyze scenario variations within complex models.

4-Component Slurry Model

The 4-Component Slurry Model is a holistic approach to characterizing how
slurry flows function by considering the combined effects of four slurry flow
regimes: the carrier fluid, pseudo-homogeneous, heterogeneous, and fully
stratified. The model strongly references and utilizes the method of the same
name outlined by GIW Industries Inc.

Pipe filling and draining

Impulse can simulate pipe filling and draining by tracking liquid-gas interfaces,
such as gas pockets, moving through the system. It uses the Method of
Characteristics for the liquid and a compressible model for the gas to capture
flow splits, surge effects, and changes in system forces. This capability helps
analyze how filling, draining, or batch movement affects system behavior.

End transient simulation based on event, Design Alert, or set time

Impulse can end a transient simulation based on specific events, Design Alerts,
or a set time. A run can stop automatically when conditions like pressure limits
are met, allowing for more precise control of the simulation. When this occurs,
output is truncated, a checkpoint file is created, and a message is logged for
review.

Parametric Study tool

The Parametric Study tool in Impulse allows systematic variation of input
parameters to analyze how changes affect system performance. It supports
sensitivity analysis, optimization, and visual trend exploration to identify key
trade-offs and operating conditions. This assists in evaluating scenarios and
supports data-driven decision-making.

Graph Annotation tool

The Graph Annotation tool places auto-updating graphs directly in the
Workspace, displaying results that refresh with each simulation run. These
graphs can be resized, moved, hidden, and layered like Color Maps, providing a
clear visual comparison of output data. This allows for real-time analysis of
model behavior without navigating away from the main workspace.
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Global Junction Morph

Impulse can convert multiple junctions from one type to another in a single step.
This tool allows system structures to be updated by selecting and changing
groups of junctions at once.
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